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Introduction 

1 Introduction 
The Event Capture Graphical User Interface (GUI) User Manual provides instructions for using 
the Event Capture options within the GUI setting. The target audience for this manual includes 
Event Capture managers, application coordinators (ADPACs) and other software users. 

The GUI provides a consistent, event driven, windows style, user interface for Event Capture. 
The GUI captures all the utilization data that is presently available in Event Capture. 

The Event Capture software provides a mechanism to track and account for procedures and 
delivered services that other VistA packages do not handle. The procedures and services tracked 
through Event Capture are associated with the following: 

• The patient to whom they were delivered 
• The provider requesting the service or procedure 
• The DSS Unit responsible for delivering the service 

DSS Units typically represent the smallest identifiable work unit in a clinical service at a medical 
center. Veterans Affairs Medical Centers (VAMCs) defines the DSS Units. A DSS Unit can 
represent any of the following: 

• An entire service. 
• A section of a service. 
• A small section within a section. 
• A medical equipment item used in patient procedures. 

The user must define the following items for every DSS Unit: 

• Service - The service associated with the DSS Unit.  
• Cost Center - Fiscal identifier for the service using the particular DSS Unit (Cost 

Centers are defined in detail in the MP4-Part V Appendix B of the Fiscal Service cost 
manuals). 

• Medical Specialty - The specialty section associated with the DSS Unit. 

1.1 Sensitive Information  
To avoid displaying sensitive information regarding our patients and staff, the examples in this 
manual contain pseudonyms or scrambled data instead of real names. Our patients and staff will 
be referred to as “ECPATIENT, ONE”, “ECPROVIDER, ONE”, or “USER, ONE.” Scrambled 
data is a series of random letters that replace a real name like “AAADY, JWHTRE”. Likewise, 
real social security numbers (SSNs), real addresses, and other personal identifiers are not used. 

1.2 Section 508-Compliant GUI  
Section 508 of the Rehabilitation Act Amendments of 1998 requires that when Federal agencies 
develop, procure, maintain, or use electronic and information technology, they shall ensure that 
the electronic and information technology enables persons with disabilities to have access to, and 
use of, information and data that is comparable to the access to and use of information and data 
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by persons who are not individuals with disabilities, unless an undue burden would be imposed 
on the agency. 

The Section 508 Accessibility Testing and Training Center (T&TC) was consulted and 
modifications to the GUI have been made to meet the requirements for 508 Compliance. Event 
Capture was modified to enable screen readers to accurately interpret information on the screens. 
As a result, some buttons and boxes have been moved, replaced, or renamed and some screen 
titles have been modified. 

For more information on the VA 508 Compliance efforts, please visit the following website: 

http://www.section508.va.gov/index.asp 

1.3 Related Manuals  
The documentation for Event Capture v2.0 includes the following related manuals. 

• Event Capture Installation Guide 
• Event Capture Technical Manual 
• Event Capture GUI Release Notes 

These documents can be found at:  

http://www.va.gov/vdl/application.asp?appid=39 

1.4 Event Capture Online Documentation 
Throughout the entire Event Capture system, click the question mark option located at the 
toolbar  or on the bottom right corner of the screen , to obtain online information 
for any screen. The information provided in the help menus corresponds with the information 
that is in this User Manual. 

To obtain online information for a field, click on that field and then click <F1>. 

Figure 1.1. Online Help Screen 
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1.5 Event Capture Interface with CPRS 
Event Capture is accessible via the Computerized Patient Record System (CPRS). This design is 
intended to increase the use of Event Capture by clinicians currently using CPRS. The creation 
of a link and a single point of entry allow users to access both systems.  

The interface between CPRS and Event Capture enables users to: 

• Access Event Capture from within CPRS through a single sign-on. 
• Select Event Capture Interface in the CPRS Tool Menu allowing the user to enter 

Event Capture patient procedures. 

1.6 Timeout Feature 
Event Capture includes a timeout feature consistent with CPRS. A countdown screen will display 
a warning of the pending timeout of the application when the Event Capture application is idle 
for a user-defined amount of time. If the user takes no action, the application will close. Click on 
the Do not close Event Capture button to stay connected.  

Figure 1.2. Event Capture Timeout Screen 

 
The amount of time for the timeout and countdown features is user-defined at the application 
server level. 

1.7 CCOW Single Sign On 
Event Capture includes Clinical Context Object Workgroup (CCOW) Single Sign-on capability. 
If a user is signed onto another CCOW Single Sign-on enabled system, launching Event Capture 
will not require the user to re-enter system Access and Verify codes. The status of the CCOW 
single sign-on is shown via an icon on a panel in the upper right hand corner of the Main Menu. 
The hover help will display “Clinical Link On” if Event Capture was accessed via CCOW single 
sign-on, or “Clinical Link Off” if it was not. The icon on the panel is updated as well. 

Figure 1.3. Event Capture CCOW Status 
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2 Orientation 
The Event Capture User Manual is intended for use as an instructional guide to using the Event 
Capture software. The user can use this manual in conjunction with the Event Capture GUI 
Online help option. 

Screen displays may vary among different sites and the data may not appear on the terminal 
exactly as shown in this manual. Although screens are subject to modification, the major menu 
options as they appear in this manual are fixed and are not subject to modification (except by the 
package developer). 

2.1 Online Help 
Help is available for many fields in the Event Capture application. Click <F1> to access the 
information needed to answer the prompt.  

2.2 Frequently Asked Questions (FAQ) 
• How can I access the Event Capture Graphical User Interface (GUI)? 

– Users need an Access Code and Verify Code obtained from their local 
Information Resource Management (IRM) staff to use the Event Capture GUI. 

• How do I logon to the Event Capture GUI? 
– Event Capture is usually accessed through a desktop shortcut that points to the 

installation location. Ask the local support staff for assistance.  
• What other logon problems should I anticipate? 

– If Event Capture launches then it disappears or is not responding, check for a 
firewall (for example, Black Ice). Make sure the listed IP address is correct and 
not blocked for the system with which it is communicating. Local support staff is 
available to assist with issues. 

• What can cause the GUI to appear distorted? Missing scrollbars? Missing columns or 
missing rows? 
– The screen resolution needs to be set to 1600 x 900  

2.2.1 Instructions for Setting Screen Resolution to 1600 x 900 
1. Right-click on the desktop and then select Screen resolution. 
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Figure 1.4. Desktop Menu Displayed After Right Click 

 

Figure 1.5. Screen Resolution Display 

 
2. Select “Normal size (1600 x 90)” from the Resolution Setting dropdown box and then 

click OK/APPLY. 
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Figure 1.6. Menu Displayed After Selecting Screen Resolution Button (NVIDIA Graphics 
Card Menu) 
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3 Before Using the Software 
Event Capture must be set up by using the options in the Event Capture Management Menu 
before any data can be entered. Access to this menu should be restricted to the ADPAC and his 
or her designees. The Event Capture ADPAC should use the following steps as a guide for 
setting up the Event Capture software. 

1. Security Keys: 
• ECMGR – Give a user access to Event Capture System (ECS) Management Menu – 

for the Event Capture Manager(s) only. 
• ECALLU – Give a user access to all DSS Units (super user). (should be assigned only 

to those managing the software (i.e., holders of the ECMGR key)) 
• ECNORPT – Restrict the user from access to the Event Capture Reports 
• ECSPSH – Give a user access to upload data from a spreadsheet. 

2. REQUIRED VISTA SETTINGS – Users must be assigned the following VistA Menu 
options in order for the ECS GUI to work. 
• EC GUI CONTEXT option. 

3. Use the Location - Update Location Information option to create an Event Capture 
location. 

Notes: 
• No further options are functional until an Event Capture location is created. 
• The selected location must be in the INSTITUTION file (#4). 
• A location must be created with this option before DSS Units can be established. 

4. Contact each service for a list of its DSS Units, the names of its Event Capture users, and 
the DSS Units for which they will enter data, and for individual product resource tracking 
needs. Use the DSS Unit - Add or Update DSS Units option to establish DSS Units for 
each service. 

Note: 
• No further options are functional until the DSS Units are created. 

5. Use the Access by User - Grant Access to DSS Units by User option to assign user access 
to specific DSS Units for the users identified in Step 2. Assign the ECALLU security key 
only to those users who should have access to all DSS units. 

Notes: 
• Users must have access to DSS Units before they can begin entering data. 
• Use the Access by User – Grant Access to DSS Units by User option to remove user 

access for a specific DSS Unit, except for those users who have the ECALLU 
security key, which overrides user access removal. 

6. Use the Category - Add or Update Categories option to create local categories before the 
user sets up Event Code screens. Creating local categories is optional. 
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Note: 
• After completion of this step, the Category Report option on the Reports Menu can be 

used to print a report of the site’s local categories. 

7. Use the Procedure - Add or Update Local Procedures option to enter new, or edit 
existing, local procedures in the EC NATIONAL PROCEDURE file (#725). Adding 
local procedures is optional. 

Notes: 
• Before starting this step, use the National/Local Procedure Report option on the 

Reports Menu to print a list of procedures with their associated CPT codes. This 
report can be quite lengthy if it includes national procedures, so it should be queued 
to print to a device during non-peak hours. 

• An associated CPT code must be entered to pass local procedures to PCE. 
• Use this option to edit, but not delete, existing local procedures and to select an 

associated CPT code if this workload data should be sent to PCE. 

8. Use the Event Code Screen - Add or Update Event Code Screens option to: 
• Create an event code screen for each procedure tracked in the Event Capture 

software.  
• Enter or edit an active associated clinic for DSS Units that are marked to send data to 

PCE. If an Associated Clinic has non-conforming stop codes, the clinic will not be 
selectable.  

• Enter or edit a procedure Synonym. 
• Enter or edit procedure Reason(s).  
• Enter or edit procedure default Volume. 

Note: 
• A screen for the procedure must be created before it can be used for data entry. 

9. Use the Print Category and Procedure Summary (Report) option on the Reports Menu to 
print the Event Code screens sorted by DSS Units. 

Notes: 
• Data entry clerks might find the output generated by this report useful as a procedure 

reference guide. 

10. Set up of Event Capture is complete. Services can now enter data using the Data Entry 
options and provide summary reports using the Reports options. 
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4 Logon 
Event Capture is accessed through a desktop shortcut that points to the installation location. if the 
shortcut does not appear, refer to the Installation Guide for Event Capture or ask the local 
support staff for assistance. 

Figure 4.1. ECS GUI Icon 

 
The VistA Sign-on screen will display. Enter the user’s VistA Access Code and Verify Code. 

Figure 4.2. VISTA Sign-on Screen 
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5 Event Capture Main Menu 
The Event Capture software contains four menus. The user must hold the appropriate security 
keys to have access to the Spreadsheet menu (ECSPSH) and to the Management Menu 
(ECMGR) and their options. To remove the Reports menu for a user, add the ECNORPT 
security key. 

The following Main Menu options display when the Event Capture GUI opens. 

Figure 5.1. Main Menu for Event Capture 

 
 

Figure 5.2. Main Menu with the ECNORPT Security Key Added for the User 
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5.1 Icon Shortcuts 
The ICON shortcuts can be used to access options in Event Capture. 

Figure 5.3. ICON Shortcuts 

 

5.2 Menu Bar 
The Event Capture menu bar enables the user to access shortcut commands. 

Figure 5.4. Main Menu Bar 

 
The File menu enables the user to Exit the window. The Function Menu on the Main window 
provides access to Data Entry, Spreadsheet, Reports and Management Menu functions. The View 
menu enables the user to show or hide the Toolbar and Status Bar. Help provides topic specific 
help or information about the Event Capture system. 

Figure 5.5. Main Menu Bar with Menus Expanded 

 

5.3 Menu Bar for Specific Functions 
The Menu Bar functions are described in the subsections below. 

5.3.1 Data Entry Menu Bar 
The Data Entry menu bar consists of the File, Edit, View, and Help menus.  
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Figure 5.6. Data Entry Menu Options 

 
The File menu enables the user to Exit the window. The Edit Menu on the Main window 
provides access to Data Entry by Patient, Data Entry by Procedure and Multiple/Multiple 
functions. The View menu enables the user to show or hide the Toolbar and Status Bar. Help 
provides topic specific help or information about the Event Capture system. 

Figure 5.7. Data Entry with Menus Expanded 

 

5.3.2 Spreadsheet Menu Bar 
The Spreadsheet menu bar consists of the File, Edit, EC Upload, Spreadsheet Options, and Help 
menus. 

Figure 5.8. Spreadsheet Upload Options 

 
The File menu enables the user to Exit the window as well as Open, Close, Save, Save As and 
Print a file. The Edit Menu on the Main window provides access to Cut, Copy, Paste, Insert Row 
and Delete Row functions. The EC Upload menu enables the user to Upload Records to VistA. 
The Spreadsheet Options menu enables the user to Change Column Headers or Change 
Duplicate Threshold. Help provides topic specific help or information about the Event Capture 
system. 

Figure 5.9. Spreadsheet Menu with Menus Expanded 
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5.3.3 Reports Menu Bar 
The Reports menu bar consists of the File, View, and Help menus. 

Figure 5.10. Reports Menu Bar 

 
The File menu enables the user to Exit the window. The View menu enables the user to show or 
hide the Toolbar and Status Bar. Help provides topic specific help or information about the Event 
Capture system. 

Figure 5.11. Reports Menu with Menus Expanded 

 

5.3.4 Management Menu Bars 
The Management menu bar consists of the File, Table, View, and Help menus. 

Figure 5.12. Management Menu Options 

 
The File menu enables the user to Exit the window. The Table Menu on the Main window 
provides access to Location, DSS Unit, Access by User, Category, Procedure, Reason, Event 
Code Screen and Inactivate EC Screen functions. The View menu enables the user to show or 
hide the Toolbar and Status Bar. Help provides topic specific help or information about the Event 
Capture system. 
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Figure 5.13. Management Menu with Menus Expanded 

 

5.4 Default Location to all Enter/Edit Screens 
On all Event Capture screens, the previous Location entry will be “saved” and used as the default 
on subsequent Location fields. 
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6 Data Entry Menu 
The Data Entry menu offers the following options: 

• Data Entry by Patient – Enter/Edit Patient Procedures 
• Data Entry by Procedure – Batch (Same Procedure, Multiple Patients) 
• Multiple Dates/Procs – Multiple Dates / Multiple Procedures 

Figure 6.1. Data Entry Menu Screen 
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6.1 Data Entry by Patient  
The following subsections describe the data entry process for patient data. 

6.1.1 Before the User Starts 
Use this option to: 

• Enter a single procedure for one patient 
• Enter multiple procedures for one patient 
• Edit an existing patient procedure 
• Delete an existing patient procedure  

Event Code screens must be defined before entering any Event Capture data. 

6.1.2 What the User Will See 
• A summary screen to identify the Location, DSS Unit, Procedure Date Range, Patient 

Identifier and the Procedures for that patient 
• A Detail screen to show the detailed information about a selected procedure 

Figure 6.2. Summary Screen for Enter/Edit Patient Procedures 

 

6.1.3 Instructions for Enter/Edit Patient Procedures Screen 
1. Select a Location. 

• If there is only one Location set up for the Event Capture System, the Location on the 
screen will default to that value. 
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• If there is more than one Event Capture Location set up, the Location will default to 
the last Location used. To change the Location, choose a Location from the dropdown 
list of available Event Capture Locations. 

2. Select a DSS Unit. 
• If one DSS Unit is defined in the Event Capture Management Menu for DSS Unit, or 

if only one DSS Unit is assigned to the user, that DSS Unit value will default. 
• If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS 

Unit from a dropdown list of accessible DSS Units. 
• The user can add, edit or delete any patient procedure for the selected DSS Unit. 
• To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - 

Add or Update DSS Units function to add the unit to the dropdown list. (Note: The 
ECMGR key is required) 

3. Select a Date Range. 
• The Procedure Date Range (from/through) will default to the system date. These 

fields may be edited by typing in a date (dd mmm yyyy) or by using the calendar 
dropdown. 

Note: 
• An edit check will prevent selecting a date in the future or selecting Procedures from 

a date that is later than the Procedures Through date. 

Figure 6.3. Calendar Dropdown for Date Range View 

 
4. Use the Patient Identifier field to select a patient. 

• Enter one of the following: 
– Patient Name (whole or partial, last name first) 
– Social Security Number 
– Last four digits of the Patient Social Security Number 
– First character of Last Name plus the last four digits of the SSN with no spaces 

• Click <Enter> or the Search button. 
• Choose from the list of patients displayed. 

5. Once the previous steps are complete, the bottom section of the window will display the 
Procedure History in chronological order for the selected patient at the selected DSS Unit 
for the date range specified. The Procedure History will display the Category, Procedure, 
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Date/Time, Volume, Associated Clinic, Ordering Section, Primary Diagnosis and 
Primary Provider. 

Notes: 
• Click on the field header to sort the data in a different order. 
• All buttons at the bottom of the screen (Close, Add, Update, Delete and Topic Help) 

are active. 
• Clicking on a previously entered Procedure, shown on the lower half of the Enter/Edit 

Patient Procedure screen, will highlight the procedure and activate the Update and 
Delete buttons. 

Figure 6.4. Procedure History for Sample Patient 

 
6. Click the Add button to do data entry. 
7. Click the Update button to display the procedure on the Edit Patient Procedure (Detail) 

screen. 
8. Click the Delete button to delete the procedure from the patient’s record. 

6.1.4 Recent Visits Pop-up Screen 
1. Click the Add button to do data entry. The Recent Visits pop-up screen will display. 
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Figure 6.5. Recent Visits Screen 

 
2. On the Recent Visits pop-up box, choose one of three options: 

• Select the appropriate Appointment/Encounter from the Recent Visits. Click OK to 
close the pop-up box. The Add Patient Procedure screen will display, which will have 
the Procedure Date/Time and Associated Clinic populated and locked, based on the 
Appointment/Encounter selected on the Recent Visits pop-up box. Enter the 
procedure(s), answer classification questions as they pertain to that visit if enabled, 
and enter diagnoses, provider, and other pertinent fields if required (reasons, ordering 
section and/or modifiers). 

Note: 
• If the Associated Clinic for the record is no longer active, the Error: Invalid 

Associated Clinic pop-up will appear. The pop-up only lists active associated clinics. 
To update the record, select an active clinic from the list and then OK. Select Cancel 
to open the record and the Associated Clinic will be blank. 
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Figure 6.6. Invalid Associated Clinic Pop-up 

 
• Click Ignore on the Recent Visits pop-up to go to an empty Add Patient Procedure 

screen to enter detail for all fields. 
• Click Cancel to close the Recent Visits pop-up and stay at the Enter/Edit Patient 

Procedure screen. 
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Figure 6.7. Add Patient Procedure (or Edit Patient Procedure) Detail Screen 

 

6.1.5 Adding Information to the Add Patient Procedure of Edit 
Patient Procedure Screen 

To complete the Add Patient Procedure or Edit Patient Procedure screen: 

1. Select a Category 
• If only one category is defined for the specified DSS Unit, that category will default. 
• If the Allow Category field in the Add DSS Unit Management set up is set to NO, 

then the Category field will be blank and disabled. 

2. Select the Procedure Date and Time. 
• This information is complete if an appointment selection occurred on the Recent 

Visits pop-up. 
• Typing “N” and then clicking <Enter> in the field (instead of clicking the  button) 

will bypass the pop-up, or clicking Now on the pop-up will enter the current system 
date and time. When the Midnight button is clicked, “23:59” is displayed for the time 
on the date selected. 
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Figure 6.8. Select Date/Time Pop-up 

 
3. Select an Eligibility Code for this procedure. 

• If the selected patient has only one Eligibility Code, that value defaults. Otherwise, 
select the Eligibility Code that applies to this procedure. 

• The primary Eligibility Code displays as the default. 

4. Select a Procedure Name. 
• Select a procedure from the dropdown list. 

5. Enter the Volume for the procedure. 
6. If applicable, the CPT Modifiers section will be enabled. 

• Modifiers provide additional information about a CPT procedure. With functionality 
put in place by the Code Set Versioning project, only CPT modifiers that are active 
for the date and time of the event will show. 

• Choose a Modifier from the Modifiers Available list and click Include. 
• Repeat as needed. 
• To remove a modifier, choose it from the Modifiers Selected list and click Exclude. 
• Click <CTRL-Click> to select multiple Modifiers at one time. 

7. If applicable, the Reasons field will be enabled. 
• The user can enter up to three reasons. 
• Reason #1 must be entered before a second or third may be entered. Reason #2 must 

be entered before a third may be entered. 
• Reasons appear alphabetically in the dropdown. 
• A reason will not appear in the dropdown list for remaining reason fields as an option 

once selected. 
• A reason can be selected by entering the initial letter(s) into the Reasons field. If the 

reason that appears is not the correct choice, click the down arrow on the reason 
dropdown to select another reason or enter different letter(s). 

8. If applicable, the mandatory classification questions section will be enabled. 
• Select YES only if the treatment received relates to that classification. 
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• Click <F1> while in the Service-Connected field will open a pop-up window 
displaying the patient’s service connection and any rated disabilities. 

Figure 6.9. Service Connection and Rated Disabilities Screen 

 
9. Select the Ordering Section. 
10. Select the associated ICD code for the procedure. 

• Use the Primary field to enter one of the following: 
– ICD code (whole or partial) 
– Diagnosis Name (whole or partial) 

• Click the Search button.  
• Select from the resulting dropdown list. 
• Repeat as needed to select the Secondary Diagnosis Codes. 

11. Select the Associated Clinic (if not already populated from Recent Visits pop-up). 
12. Select the providers of the services. Use the Providers Available text box to enter the 

following: 
• Provider name (full or partial, last name first) 
• Select the provider from the resulting dropdown list and click Include. 
• To remove a provider, select from the Providers Selected list and click Exclude.  

13. Click the Add button to save the edited procedure. 
14. Click the OK button to save the edited procedure and return to the Enter Patient 

Procedure screen. 
15. Click the Cancel button to return to the Enter Patient Procedure screen without saving the 

above entries. 

Notes: 
• If the record transmits to PCE based on the DSS Unit on Management Menu set up, 

then all fields will be required. 
• If the record does not transmit to PCE based on the DSS Unit on Management Menu 

set up, then the Associated Clinic and the four Secondary Diagnosis fields will be 
disabled. 
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• Click <F1> while in any field to open a pop-up window displaying a Help message. 

6.1.6 Add a Patient Record 
The following instructions and example assume that a user is entering a new procedure for a 
specified patient and that the specified DSS Unit data transmits to PCE. 

1. On the Main Menu, select Data Entry. 
2. On the Data Entry Menu, select Data Entry by Patient. 
3. The Edit Patient Procedures screen appears.  
4. Select the Location and DSS Unit. 
5. Allow the Procedure Date Range to default to today. 
6. Select a Patient. 

Figure 6.10. Edit Patient Procedure Summary Screen 

 
7. Click Add. 
8. The Recent Visits screen will appear. Click Ignore. 
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Figure 6.11. Add Patient Procedure Detail Screen 

 
9. Complete the procedure related fields on the Add Patient Procedure detail screen 

according to the field-by-field instructions given earlier. 
10. Click Add to save the Detail entries and open another Detail screen for this patient. 
11. Click OK to save the Detail entries and return to the Enter/Edit Patient Procedures 

screen. 
12. The Enter/Edit Patient Procedures screen will display the procedure(s) entered for this 

patient. 
13. Click Close to return to the Data Entry menu. 
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Figure 6.12. Enter/Edit Patient Procedures with New Procedure Added 

 

6.1.7 Edit a Patient Procedure 
1. On the Main Menu, select Data Entry. 
2. On the Data Entry Menu, select Data Entry by Patient. 
3. The Enter/Edit Patient Procedures summary screen appears. 
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Figure 6.13. Enter/Edit Patient Procedures Summary Sheet 

 
4. Select the Location and DSS Unit. 
5. Enter a Procedure Date Range by using the calendar dropdowns. The default is today. 
6. Select a Patient. 
7. The lower portion of the screen will display the procedure(s) for the selected patient and 

the DSS Unit within the date range. 
8. Choose a procedure and click Update. 
9. The Edit Patient Procedure screen appears. 
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Figure 6.14. Edit Patient Procedure Screen 

 
10. Complete the procedure related fields on the Edit Patient Procedure detail screen 

according to the field-by-field instructions given earlier. 
11. Click Add to save the detail entries and open another detail screen for this patient. 
12. Click OK to save the detail entries and return to the Enter/Edit Patient Procedures screen. 
13. The Enter/Edit Patient Procedures screen will display the procedure(s) entered for this 

patient. 
14. Click Close to return to the Data Entry menu. 

6.1.8 Delete a Patient Procedure 
1. On the Main Menu, select Data Entry. 
2. On the Data Entry Menu, select Data Entry by Patient. 
3. The Enter/Edit Patient Procedures summary screen appears. 
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Figure 6.15. Enter/Edit Patient Procedure Screen 

 
4. Select the Location and DSS Unit. 
5. Enter a Procedure Date Range by using the calendar dropdowns. The default is today. 
6. Select a patient. 
7. The lower portion of the screen will display the procedure(s) for the selected patient and 

the DSS Unit within the date range. 
8. Choose a procedure and click Delete. 
9. A confirmation message appears. 

• Click Yes and a pop-up appears to show the selected procedure was deleted for the 
patient. Click OK to return to the Enter/Edit Patient Procedures screen. 

• Click No to return to the Enter/Edit Patient Procedures screen. 

Figure 6.16. Confirmation Message 

 

Figure 6.17. Procedure Deleted Pop-up 
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10. The screen will now refresh to show the remaining procedures entered for this patient. 

Figure 6.18. Enter/Edit Patient Procedures Screen with Procedure Deleted 

 
11. Click Close to return to the Data Entry menu. 
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6.2 Data Entry by Procedure 
The following subsections describe the step-by-step process for entering data.  

6.2.1 Before the User Starts 
• Enter / edit the same procedure for multiple patients 
• Event Code screens must be defined before entering any Event Capture data. 
• Use the Data Entry by Patient option to make corrections to erroneous patient data. 

6.2.2 What the User Will See 
• The left half of the screen contains information for the procedure that the user will 

add for each patient. (Note: The user will enter the procedure information only one 
time.) 

• The right half of the screen identifies each patient. The user will complete this section 
for each patient. Click Add to get a refreshed screen for the next patient. 

• The View button displays a listing of all patients entered for this procedure in this 
session. 

Figure 6.19. Same Procedure, Multiple Patients Screen 
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6.2.3 Instructions for Adding a Procedure for Multiple Patients 
The following instructions and example assume that the user wants the specified DSS Unit to 
send data to PCE. 

1. Select a Location. 
• If there is only one Location set up for the Event Capture System, the Location on the 

screen will default to that value. 
• If there is more than one Event Capture Location set up, the Location will default to 

the last Location used. To change the Location, choose a Location from the dropdown 
list of available Event Capture Locations. 

2. Select a DSS Unit. 
• If one DSS Unit is defined in the Event Capture Management Menu for DSS Unit, or 

if only one DSS Unit is assigned to the user, that DSS Unit value will default. 
• If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS 

Unit from a dropdown list of accessible DSS Units. 
• The user can add, edit or delete any patient procedure for the selected DSS Unit. 
• To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - 

Add or Update DSS Units function to add the unit to the dropdown list. 

3. Select a Category. 
• If only one category is defined for the specified DSS Unit, that category will be the 

default. 

4. Select the Procedure Date and Time. 

• Typing “N” and then clicking <Enter> in the field (instead of clicking the  button) 
will bypass the pop-up, or clicking Now on the pop-up will enter the current system 
date and time. When the Midnight button is clicked, “23:59” is displayed for the time 
on the date selected. 

Figure 6.20. Select Date/Time Pop-up 

 
5. Select a Procedure Name. 

• Select a procedure from the dropdown list. 
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6. If applicable, the Reasons field will be enabled.  
• The user can enter up to three reasons. 
• Reason #1 must be entered before a second or third may be entered. Reason #2 must 

be entered before a third may be entered. 
• Reasons appear alphabetically in the dropdown. 
• A reason will not appear in the dropdown list for remaining reason fields as an option 

once selected. 
• A reason can be selected by entering the initial letter(s) into the Reasons field. If the 

reason that appears is not the correct choice, click the down arrow on the reason 
dropdown to select another reason or enter different letter(s). 

7. If applicable, the CPT Modifiers section will be enabled. 
• Modifiers provide additional information about a CPT procedure. With functionality 

put in place by the Code Set Versioning project, only CPT modifiers that are active 
for the date and time of the event will show. 

• Choose a Modifier from the Modifiers Available list and click . Repeat as 
needed. 

• To remove a modifier, choose it from the Modifiers Selected list and click .  
• Click <CTRL-Click> to select multiple Modifiers at one time. 

8. Select the providers of the services. Use the Providers Available text box to enter the 
following: 
• Provider name (full or partial, last name first) 

• Select the provider from the resulting dropdown list and click . 

• To remove a provider, select from the Providers Selected list and click . 

9. Use the Patient Identifier field to select a patient. 
• Enter one of the following: 

– Patient Name (whole or partial, last name first) 
– Social Security Number 
– Last four digits of the Patient Social Security Number 
– First character of Last Name plus the last four digits of the SSN with no spaces 

• Click <Enter> or the Search button.  
• Choose from the list of patients displayed.  

10. Select an Eligibility Code for this procedure. 
• If the selected patient has only one Eligibility Code, that value defaults. Otherwise, 

select the Eligibility Code that applies to this procedure. 
• The primary Eligibility Code displays as the default. 

11. Enter the Volume for the procedure. 
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12. If applicable, the mandatory classification questions section will be enabled. 
• Select YES only if the treatment received relates to that classification. 
• Click <F1> while in the Service-Connected field will open a pop-up window 

displaying the patient’s service connection and any rated disabilities. 

Figure 6.21. Service Connection and Rated Disabilities Screen 

 
13. Select the Ordering Section. 
14. Select an Associated Clinic for the specified DSS Unit, if applicable. 
15. Select the associated ICD diagnosis code for the procedure. 

• Use the Primary field to enter one of the following: 
– ICD code (whole or partial) 
– Diagnosis Name (whole or partial) 

• Click the Search button.  
• Select from the resulting dropdown list. 
• Repeat as needed to select the Secondary Diagnosis Codes. 

16. Click the Add button to add this procedure for the patient. The right side of the screen 
will reset to enter this procedure for another patient. Select the next patient for this 
procedure. Repeat the patient related steps above. 

17. Click the OK button to add this procedure to the patient’s record and return to the Data 
Entry menu. 

18. Click the View button to verify that the list of patients entered is correct. The following 
screen will list all of the patients entered for the procedure that was selected. 
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Figure 6.22. View Patients for this Procedure Screen 

 
19. To correct an entry, return to the Data Entry menu and select Data Entry by Patient. 
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6.3 Multiple Dates/Procedures 

6.3.1 Before the User Starts 
• Add multiple dates and multiple patients for multiple procedures. 
• Event Code screens must be defined before entering any Event Capture data. 
• Use the Data Entry by Patient option to make corrections to erroneous patient data. 

6.3.2 What the User Will See 
• An area at the top of the first screen for entering common fields (Location, DSS Unit 

and Category) as well as the Procedure Date/Time. 
• Three tabs for entering providers, procedures and patients. 
• Two tabs for checking work before submitting. 

Figure 6.23. First Screen Encountered Upon Entering Multiple Dates/Multiple Procedures 

 

6.3.3 Instructions for Common Fields 
1. Select a Location. 

• If there is only one Location set up for the Event Capture System, the Location on the 
screen will default to that value. 
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• If there is more than one Event Capture Location set up, the Location will default to 
the last Location used. To change the Location, choose a Location from the dropdown 
list of available Event Capture Locations. 

2. Select a DSS Unit. 
• If one DSS Unit is defined in the Event Capture Management Menu for DSS Unit, or 

if only one DSS Unit is assigned to the user, that DSS Unit value will default. 
• If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS 

Unit from a dropdown list of accessible DSS Units. 
• The user can add, edit or delete any patient procedure for the selected DSS Unit. 
• To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - 

Add or Update DSS Units function to add the unit to the dropdown list. 

3. Select a Category. 
• If only one category is defined for the specified DSS Unit, that category will be the 

default. 

4. Select the Procedure Dates and Times by using the Select Date/Time popup window. 

Figure 6.24. Select Date/Time Pop-up 

 
• Select date and time and click OK to return to close the pop-up. 
• Click the Add Date/Time button to add the choice to the Selected Dates list. 
• Select and add dates as needed. 
• To remove a date, choose it from the list and click the Delete Date/Time button. 

Notes: 
• To bypass the pop-up, type “N” and click  <Enter> in the field (instead of clicking 

the  button. 

• To enter the current system date and time, Click Now on the pop-up. 

• When the Midnight button is clicked, “23:59” is displayed for the time on the date 
selected. 
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5. Click and complete the tabs for Providers, Procedures and Select Patient as described 
below. 

6. Use the View Selected Patients and Records Pending Filing tabs to check the work as 
described below. 

7. Click the Save button at the bottom of the screen to process the transactions shown on the 
Records Pending Filing tab and then redisplay the screen initialized for a new set of 
entries. 

8. Click the OK button at the bottom of the screen to process the transactions shown on the 
Records Pending Filing tab and then return to the Data Entry menu. 

6.3.4 Adding Information to Providers Tab 
1. Click on the Providers tab to select one or more providers. 

Figure 6.25. Providers Tab on Multiple Dates/Multiple Procedures Screen 

 
2. Select a Provider. 

• Use the Providers Available text box to enter the full or partial Provider name (last 
name first) 

• Select the provider from the resulting dropdown list and click Include. 
• To remove a provider, select from the Providers Selected list and click Exclude. 
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3. Repeat as needed to add providers. 

6.3.5 Adding Information to Procedures Tab 
1. Click on the Procedures tab to select one or more procedures. 

Figure 6.26. Procedures Tab on Multiple Dates/Multiple Procedures Screen 

 
2. Select a Procedure Name. 

• Select a procedure from dropdown list. 

3. Enter the Volume for this procedure. 
4. If applicable, the Reasons field will be enabled. 

• The user can enter up to three reasons. 
• Reason #1 must be entered before a second or third may be entered. Reason #2 must 

be entered before a third may be entered. 
• Reasons appear alphabetically in the dropdown. 
• A reason will not appear in the dropdown list for remaining reason fields as an option 

once selected. 
• A reason can be selected by entering the initial letter(s) into the Reasons field. If the 

reason that appears is not the correct choice, click the down arrow on the reason 
dropdown to select another reason or enter different letter(s). 
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5. If applicable, the CPT Modifiers section will be enabled. 
• Modifiers provide additional information about a CPT procedure. With functionality 

put in place by the Code Set Versioning project, only CPT modifiers that are active 
for the date and time of the event will show. 

• Choose a Modifier from the Modifiers Available list and click Include. 
• Repeat as needed. 
• To remove a modifier, choose it from the Modifiers Selected list and click Exclude. 
• Click <CTL-Click> to select multiple Modifiers at one time. 

6. Click the Add Procedure button to add this procedure to the Procedures Selected list and 
display a blank screen ready for another entry. 

7. To add another procedure, repeat the steps above. 
8. To delete a procedure, choose it from the Selected Procedures list and click the Delete 

Procedure button. 
9. To view a procedure in an expanded format, choose it from the Selected Procedures list 

and click the View Details button. The View Procedure Record Details screen is not 
editable. 

Figure 6.27. View Details Screen 

 
10. Click the Close Procedure View button to return to the Procedures tab. 

6.3.6 Adding Information to Select Patient Tab 
1. Click on the Select Patient tab to select one or more patients. 
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Figure 6.28. Select Patient Tab on Multiple Dates/Multiple Procedures Screen 

 
2. Use the Patient Identifier field to select a patient. 

• Enter one of the following: 
– Patient Name (whole or partial, last name first) 
– Social Security Number 
– Last four digits of the Patient Social Security Number 
– First character of Last Name plus the last four digits of the SSN with no spaces 

• Click <Enter> or the Search button.  
• Choose from the list of patients displayed.  

3. Select an Eligibility Code for this procedure. 
• If the selected patient has only one Eligibility Code, that value defaults. Otherwise, 

select the Eligibility Code that applies to this procedure.  
• The primary Eligibility Code displays as the default. 

4. If applicable, the mandatory classification questions section will be enabled. 
• Select YES only if the treatment received relates to that classification. 
• Click <F1> while in the Service-Connected field will open a pop-up window 

displaying the patient’s service connection and any rated disabilities. 
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Figure 6.29. Service Connection and Rated Disabilities Screen 

 
5. Select the Ordering Section. 
6. Select the Associated Clinic. 
7. Select the associated ICD code for the procedure. 

• Use the Primary field to enter one of the following: 
– ICD code (whole or partial) 
– Diagnosis Name (whole or partial) 

• Click the Search button.  
• Select from the resulting dropdown list. 
• Repeat as needed to select the Secondary Diagnosis Codes. 

8. Click the Add Patient button to add this patient to the list of Selected Patients and 
display a blank screen ready for another entry. 

9. Use the View Selected Patients tab to check the work. 

6.3.7 Using View Selected Patients Tab to Verify Information 
1. Click on the View Selected Patients tab to review the list of selected patients. 
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Figure 6.30. View Selected Patient Tab on Multiple Dates/Multiple Procedures Screen 

 
2. To remove a patient from the list, select record and click the Delete Patient button. Click 

Yes on the Confirmation pop-up. 

Figure 6.31. Deleting Patient Confirmation Pop-up 

 
3. To view a patient in an expanded format, select the record and click the View Details 

button. The patient record is not editable using the View Patient Record Detail screen. 
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Figure 6.32. View Patient Record Details Screen 

 
4. Click the Close Patient View button to return to the View Selected Patients tab. 

6.3.8 Using Records Pending Filing Tab to Verify Information 
1. Click on the Records Pending Filing tab to view a list of the records to be filed.  

Note: 
• This screen is not editable. 
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Figure 6.33. Records Pending Filing Tab on Multiple Dates/Multiple Procedures Screen 

 
2. This screen lists the individual records (transactions) that will be processed when the OK 

or Save button at the bottom of the screen is clicked. A pop-up will appear on the screen 
to show the number of records added. 

Note: 
• Click OK to return to the Data Entry menu or click Save to add further entries. 

Figure 6.34. Information Pop-up After Saving 

 
3. The records consist of every combination of the dates, procedures, and patients selected 

on the tabs described above and the providers selected will be assigned to each record. 
4. To change the list, review and revise the selections on the Providers, Procedure and 

Select Patient tabs and for the Selected Dates/Times field. 
5. To correct an entry, return to the Data Entry menu and select Data Entry by Patient. 
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7 Spreadsheet 
This section describes the process for creating and populating a spreadsheet. 

7.1 Enter Data via the Event Capture Spreadsheet 
The following subsections describe the steps to enter data in the Event Capture Spreadsheet. 

7.1.1 Before the User Stats 
• The Spreadsheet screen in the ECS GUI application enables users to open an existing 

file containing their workload data and upload it to the EVENT CAPTURE 
PATIENT file (#721). 

• The Spreadsheet application can work with existing Excel files and tab or comma 
delimited files. All versions of Excel are compatible with this functionality 

• Each record in the spreadsheet is validated before being filed in the EVENT 
CAPTURE PATIENT file (#721). Two levels of validation occur. The first level of 
validation occurs within Delphi. A check for necessary information is performed and 
no data transmits to VistA if the Delphi validation is not ‘passed’ for every record in 
the spreadsheet. After passing that level of validation, the RPC broker is “called” and 
each record transmits (one by one) to VistA for validation. If an error occurs during 
this process, an error message displays and the record is not filed. If an error does not 
occur, the record is filed in the EVENT CAPTURE PATIENT (#721) file. This 
process occurs until all records have been validated. The records that are filed will be 
removed from the spreadsheet grid, leaving only those records with errors. The error 
message(s) display in the error message box, and the records can be edited or deleted 
before retransmitting. 

7.1.2 What the User Will See 
The user will see a spreadsheet upload screen similar to the screenshot below. 
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Figure 7.1. Spreadsheet Upload Screen 

 

7.2 Enter Data via the Event Capture Spreadsheet Upload 
1. When starting the Spreadsheet Upload, the column headers display in a default order. The 

user can change the order of the columns. To do this, click on the Column Header 
button  to change the order as needed. 

Notes: 
• To change column order, the user can select the Spreadsheet Options menu and click 

on Change Column Headers 
• Help is available for each column in the spreadsheet. Click on any column and then 

click on the Help button . 

2. If an error message displays in the error message box, click on the error message to 
highlight the cell in the grid that most likely caused the error. 

3. If more than one provider exists with that name in the spreadsheet (or if there is a partial 
name match), the application will return matching and partial-matching provider 
information (provider name, IEN, specialty, subspecialty, person class) to the error box. 
The desired provider can be determined and the user can enter the correct name or IEN 
information into the spreadsheet (as necessary). 
• For example, provider name ECPROVIDER, ONE may return provider information 

for ECPROVIDER, ONE, ECPROVIDER, ONE A and ECPROVIDER, ONE B. 
Provider name ECPROVIDER, THIRTY may return information for ECPROVIDER, 
THIRTY-ONE and ECPROVIDER, ONE HUNDRED THIRTY. 

4. To determine if the inpatient record needs to be uploaded, check the patient status for that 
particular date/time. If it is determined to be an inpatient record, then an ‘Inpatient 
Override’ checkbox appears on the screen, a warning message appears in the error 
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message box, and the record returns for editing by the user. The user has the following 
options: 
• Override the inpatient-warning message by selecting the Inpatient Override checkbox 

and then retransmit. The record uploads as inpatient. 
• Change the Encounter date/time and upload it as outpatient. 

5. If the system detects duplicate records when the spreadsheet uploads, a ‘File Duplicate 
Record(s)’ checkbox appears on the screen. The duplicate records display in the error 
message box. If any duplicates exist when all of the records process, the prompt 'File 
Duplicate Record(s)' check box appears. Selecting the check box and retransmitting files 
eliminates the duplicate records in EVENT CAPTURE PATIENT file (#721). 

6. To delete only the contents of one cell, double click in the spreadsheet grid and click 
<Delete>. To delete an ENTIRE RECORD, click once on a cell and then click <Delete>.  

7. Column Headers - When starting the spreadsheet upload program, the column headers 
display in a default order. The user can change the column order at any time (before and 
after transmitting data to VistA). To change the column header order, select ‘Spreadsheet 
Options’, ‘Change Column Headers’. The default column header order is as follows: 
• Record number 
• Location 
• Pat SSN 
• Pat LName 
• Pat Fname 
• DSS Unit Name 
• DSS Unit Num 
• DSS Unit IEN 
• Proc Code 
• Volume 
• Ordering Sect 
• Prov Name or IEN 
• Enc Date/Time 
• Category 
• Diag Code 
• Assoc Clinic 

7.3 Spreadsheet Column Errors 
The following errors may display while uploading data into Event Capture via the Spreadsheet 
option: 

• Record Number: Each record in the spreadsheet needs a unique record number 
(during each transmission), i.e., 1, 2, 3, etc. An error appears before VistA validation 
occurs if this field is blank. If the record number is not unique and there are no errors 
for that record number on the VistA side during validation, then there is no problem 
and the data will transmit successfully. If the record number is not unique and an 
error has occurred on the VistA side, then the error messages is not properly mapped 
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to the record(s) in error, and you will need to give it a unique record number at that 
point and retransmit the record(s) in error. 
– Delphi messages 

• Error getting column with Record number 
• Record number is a mandatory field 
 

• Location: The Location number must exist on the INSTITUTION file (#4, 
^DIC(4,D0,0)). 
– VistA message 

• Location not on INSTITUTION file (#4) 
 

• Pat SSN: Patient SSN must exist on the PATIENT file (#2, ^DPT). If the SSN is 
shorter than 9 digits, it will be left filled with zeroes. Do not use dashes in the SSN. 
– VistA messages 

• No SSN x-ref on PATIENT file (#2) 
• No SSN entry on PATIENT file (#2) 
• No internal entry on PATIENT file (#2) for SSN x-ref 
• SSN does not match SSN on PATIENT file (#2) 
 

• Patient LName and Patient FName: Patient last and first name - The patient’s name 
(last name, first name) must match the name on the PATIENT file (#2) for that SSN. 
– Delphi messages 

• Error getting column with Patient LName 
• Patient LName must be at least 2 characters long 

– VistA messages 
• Patient last name does not match VistA 
• Patient first name does not match VistA 
 

• DSS Unit Name: If this field contains a value, then it must have a “B” cross-
reference on the DSS UNIT file (#724). The DSS Unit Name is not required if the 
DSS Unit IEN or the DSS Number column is filled in. 
– VistA message 

• Invalid DSS Unit Name 
 

• DSS Unit Number: This is the Unit Number, found on the DSS UNIT file (#724). If 
this field contains a value, then it must have a “C” cross-reference on the DSS UNIT 
file (#724). The DSS Unit Number is not required if the DSS Unit IEN or the DSS 
Unit Name is filled in. 
– VistA message 

• Invalid DSS Unit Number 
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• DSS Unit IEN: If this field contains a value, then it must exist on the DSS UNIT file 
(#724). The DSS Unit IEN is not required if the DSS Unit Name or the DCM Dept is 
filled in. 
– VistA message 

• Invalid DSS Unit IEN 
 

• Proc Code: This is the procedure/CPT code value (not the description). The National 
Procedure, Local Procedure and CPT code are all valid codes for this column. The 
procedure/CPT must exist on the EC NATIONAL PROCEDURE file (#725) or the 
CPT file (#81), and the EC Event Code Screen must be ‘active’ for the Location, DSS 
Unit IEN, and Procedure/CPT combination. With functionality put in place by the 
Code Set Versioning project, only CPT codes that are active for the date and time of 
the event are processed. 
– VistA messages 

• Procedure or “D” x-ref not on EC NATIONAL PROCEDURE file (#725) 
• Procedure invalid for this Location and DSS Unit 
• Unable to check for active EC Event Code Screen 
 

• Volume: The volume must be a number from 1 through 99. 
– Delphi error messages 

• Error getting column with Volume number 
• Volume is a mandatory field 
• Volume has a limit of 2 digits 

– VistA messages 
• Volume must be a number from 1 to 99 
• Volume must contain numeric characters only 
 

• Ordering Section: This is the name of the Ordering Section. A validation occurs for 
ordering sections entered into the spreadsheet by the user (against the “B” cross 
reference in the MEDICAL SPECIALTY file (#723)). If the user leaves this field 
blank, the program will derive the Ordering Section from DSS UNIT file (#724) 
using the DSS Unit IEN. It will then transmit to the Event Capture filer program. 
– VistA message 

• Invalid Ordering Section 
• Unable to determine Ordering Section 
 

• Prov Name or IEN: This is the Provider’s last and first name as it appears in the “B” 
cross reference of the NEW PERSON file (#200). If the provider also has a middle 
initial, then it should be included, i.e. ‘ECPROVIDER, SEVEN J’. If the system finds 
a partial match for name, the application will return the provider information 
(provider name, IEN, specialty, subspecialty, person class) for all options to the error 
box, and you can then determine which provider they want. The Provider must have a 
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“B” cross-reference and exist on the NEW PERSON file (#200) and the person class 
must be ‘active’. 

 
LASTNAME, FIRSTNAME, or IEN 
 
– VistA messages 

• Provider has no B x-ref on NEW PERSON file (#200) 
• Unable to determine person class 
• Provider does not have an active person class 
 

• Enc Date/Time: The Encounter Date/Time can be in any valid FileMan format. 
Examples: 
mm/dd/yy @hh:mm 
mm/dd/yyyy @hh:mm 
mm-dd-yy @hh:mm 
mmddyy @hhmm 
N, N-1, N-1H, etc. 
 
– VistA message 

• Invalid encounter date/time 
 

• Category: The Category field can be blank. If the user enters a value, it needs to have 
a B cross-reference in the EC CATEGORY file (#726). 
– VistA message 

• Category "B" x-ref not on EC CATEGORY file (#726) 
 

• Diag Code: This is the primary diagnosis code value. It must exist on the ICD 
DIAGNOSIS file (#80). With functionality put in place by the Code Set Versioning 
project, only ICD codes that are active for the date and time of the event process are 
valid. The Diagnosis Code is only required for records sent to PCE. The system 
ignores it otherwise. 
– VistA messages 

• Diagnosis code is required for this DSS Unit 
• Unable to retrieve Diagnosis IEN 
 

• Assoc Clinic: This is the Associated Clinic name. It must have a “B” cross-reference 
on the HOSPITAL LOCATION file (#44), be of type “C” (clinic), and be ‘active’ for 
that encounter date. The Associated Clinic must have conforming stop codes to be 
selectable. The Associated Clinic is only required for records sent to PCE and will be 
ignored otherwise. 
– VistA messages 

• Associated Clinic is required for this DSS Unit 
• Assoc Clin "B" x-ref not found on HOSPITAL LOCATION file (#44) 
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• Assoc Clin not found on HOSPITAL LOCATION file (#44) 
• Associated Clinic must be of type "C" (clinic) 
• Associated Clinic inactive for this encounter date 

7.4 Other Logic 
• DSS Unit IEN: The system obtains the DSS Unit IEN by checking the DSS Unit IEN 

field, the DCM Dept field and the DSS Unit Name field (only one is needed). If any 
of the three columns contain erroneous data, an error message displays and the record 
is not filed. 

• Send to PCE: Using the DSS Unit, the application determines if the record transmits 
to PCE. If so, the application then validates the Associated Clinic and Diagnosis 
Code. If not, the system ignores these two columns. 

7.5 Uploading Data via Event Capture Spreadsheet 
1. Click on the Spreadsheet button in the Main Menu.  
Note: This functionality is compatible with all versions of Excel. 
2. Click Open in the File menu to display a list of Excel files from which to choose. Find 

Excel file and click Open. A list of patient data will appear with column headings for 
Record Number, Station Number, Patient first and last name, SSN, DSS Unit Number 
and IEN, DCM Department, Procedure and Diagnosis Code, Volume, Service, Provider 
first and last name, Encounter Date/Time, and Associated Clinic. 

Figure 7.2. Selecting a File to Upload Prior to Excel 2007 
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Figure 7.3. Selecting a File to Upload for Excel 2007 or Newer 

 

Figure 7.4. Sample Data for Spreadsheet Upload 

 
Note: The user can change the spreadsheet column order. 
3. To change the spreadsheet with a different order, click on the Column Header button  

or select the Spreadsheet Options menu and click on Change Column Headers to 
change the order. 
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Figure 7.5. Change Column Headers Pop-up 

 
4. To change the order of the columns, highlight the column heading in the list and click on 

the Move Up and Move Down buttons. Continue to change the column heading order 
until it matches the spreadsheet used and then upload the spreadsheet. 
Note: At this point, the user can change the Duplicate Threshold value through the 
Spreadsheet Options dropdown menu by selecting Change Duplicate Threshold. 
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Figure 7.6. Changing Duplicate Threshold 

 
5. Click on Transmit EC Data to VistA in the EC Upload menu or the Update Records to 

VistA button  in the toolbar. The data is validated and uploaded and error messages 
display for those records containing errors.  

6. The Spreadsheet checks for duplicate records, based on the Location (Station number), 
Patient SSN, DSS Unit, and Procedure Date/Time. The duplicate records display below 
the spreadsheet. When the user-defined threshold of duplicate records is reached, a 
message box will display with the options of Continue, Change and Abort. 

Figure 7.7. Duplicate Records Threshold Reached Screen 

 
• Continue: resets the counter and resumes processing of records. 
• Change: The Duplicate Threshold defaults to a user-defined number. The Duplicate 

Threshold value can be changed two ways: 
• From the Spreadsheet Options dropdown menu, select Change Duplicate 

Threshold  
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• When the threshold is reached and the Duplicate Record Threshold Reached window 
is displayed, click the Change button 

• Abort: terminates the upload process. 

Figure 7.8. Aborting Process Pop-up 

 
7. The user can correct/delete records with errors and the spreadsheet retransmitted. 

Figure 7.9. Sample Data with Error Messages Before Upload 

 
8. When the data transmits, only those records with errors will return.  
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Figure 7.10. Errors Remaining After Data Transmits 

 
9. Any records filed into the EVENT CAPTURE PATIENT file (#721) will not appear in 

the spreadsheet grid after transmission. A message will appear in the status bar at the 
bottom of the screen with a count of successfully transmitted records and a count of how 
many error messages there are. 

Figure 7.11. Spreadsheet Showing Successfully Transmitted Records 
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8 Reports 
8.1 Reports Available to All Users (Including ECMGR Key 

Holders) 
• DSS Unit Activity Report 
• DSS Unit Workload Report 
• ECS Records Failing Transmission to PCE Report 
• Event Capture Encounters Report 
• Ordering Section Summary Report  
• Patient Summary Report 
• PCE Data Summary Report 
• Procedure Reasons Report 
• Provider Summary Report 
• Provider (1-7) Summary Report 

Figure 8.1. Report Selection Screen for All Users 
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8.1.1 DSS Unit Activity Report 
• The report can be sorted by patient, provider or SSN. 
• If more than one location has been set up, choose one or all locations. 
• After previewing the report, the user will have the option to print or close the report. 

1. Enter a date range. 
2. Select one or all Location(s). 
3. Select one or all DSS Unit(s). 
4. Choose Sort Method (Patient, Provider or SSN) for the report. 

Notes: 
• Only the last four digits of the patient’s SSN will appear on the print preview of this 

report. 
• The column order does not change with Sort Method when exported into Excel. 

5. Export, Preview, Print or Cancel the report. 

Figure 8.2. DSS Unit Activity Report Required Information 
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Figure 8.3. DSS Unit Activity Report from Print Preview 

 

Figure 8.4. DSS Unit Activity Report from Export 
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8.1.2 DSS Unit Workload Report 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred 

• After previewing the report, the user will have the option to print or close the report. 

1. Enter a date range. 
2. Select one or all location(s). 
3. Select one or all DSS Unit (s). 
4. Export, Preview, Print or Cancel the report. 

Figure 8.5. Required Information for DSS Unit Workload Report 
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Figure 8.6. DSS Unit Workload Report from Print Preview 

 

Figure 8.7. DSS Unit Workload Report from Export 
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8.1.3 ECS Records Failing Transmission to PCE Report 
• Locations, DSS Units, procedures, five-character EC National Codes (when 

applicable) and categories must be defined before using this option. 
• After previewing the report, the user has the option to print or close the report. 

1. Select the date Range. 
2. Export, Preview, Print or Cancel the report. 

Figure 8.8. ECS Records Failing Transmission to PCE Report Required Fields 
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Figure 8.9. ECS Records Failing Transmission to PCE Report from Print Preview 

 

Figure 8.10. ECS Records Failing Transmission to PCE Report from Export 
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8.1.4 Event Capture Encounters Report 
• Displays and counts the unique occurrences by patient and DSS Unit during a 

selected date range. It also enables sorting by patient or by provider. 
– When sorted by Patient shows the number of unique occurrences for the Patient 

across the date range that is selected.  
– When sorted by Provider shows the number of unique occurrences for the 

Provider across the date range that is selected. 
• Includes the fields Patient Name, SSN (last 4 digits), Inpatient or Outpatient (I/O), 

Date/Time, Provider #1, DSS Unit and Volume. 
• After previewing the report, the user has the option to print or close the report. 

1. Select a date range. 
2. Select a Location. 
3. Select one, all or multiple DSS Unit(s). 
4. Select Sort Method (Patient or Provider). 
5. Export, Preview, Print or Cancel the report. 

Notes: 
• Only the last four digits of the patient’s SSN will appear on the print preview of this 

report. 
• The column order does not change with Sort Method when exported into Excel. 
• A report timeout warning and a pop up window are displayed when All Locations, 

All DSS units or large date ranges are selected.  
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Figure 8.11. Event Capture Encounters Report Required Fields 

 

Figure 8.12. Event Capture Encounters Report Timeout Warning 
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Figure 8.13. Event Capture Encounters Report Sorted by Patient from Print Preview 

 

Figure 8.14. Event Capture Encounters Report Sorted by Provider from Print Preview 

 

Figure 8.15. Event Capture Encounters Report from Export 
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8.1.5 Ordering Section Summary Report 
• The design of this report is for a 132-column format. 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred. 

• After previewing the report, the user will have the option to print or close the report. 

1. Enter a date range. 
2. Select an Ordering Section. 
3. Select a specific or all Location(s). 
4. Select one, multiple, or all DSS Unit(s). 
5. Export, Preview, Print or Cancel the report. 

Figure 8.16. Ordering Section Summary Report Required Information 

 

June 2015 Event Capture V. 2.0 GUI User Manual 68 
Patch EC*2.0*126 



Reports – Ordering Section Summary 

Figure 8.17. Ordering Section Summary Report from Print Preview 

 

Figure 8.18. Ordering Section Summary Report from Export 
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8.1.6 Patient Summary Report 
• The design of this report is for a 132-column format. 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred.  

• The user can choose to include Procedure Reasons (EVENT CAPTURE PATIENT 
file (#721)) on the report. Up to three reasons will be included. 

• The “Display Reasons on this report” will clear when the user selects another report 
or upon exiting the screen. 

• After previewing the report, the user will have the option to print or close the report. 

1. Enter a date range. 
2. Use the Patient Identifier field to select a patient. 

• Enter one of the following: 
– Patient Name (whole or partial, last name first) 
– Social Security Number 
– Last four digits of the Patient Social Security Number 
– First character of Last Name plus the last four digits of the SSN with no spaces 

• Click <Enter> or the Search button.   
• Choose from the list of patients displayed. 

3. Choose whether to include Procedure Reasons in the report. 
4. Export, Preview, Print or Cancel the report.  
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Figure 8.19. Patient Summary Report Required Information without Reasons 

 

Figure 8.20. Patient Summary Report from Report Preview without Reasons 
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Figure 8.21. Patient Summary Report from Export without Reasons 

 

Figure 8.22. Patient Summary Report Required Information with Reasons Checked 
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Figure 8.23. Patient Summary Report from Report Preview with Reasons 

 

Figure 8.24. Patient Summary Report from Export with Reasons 
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8.1.7 PCE Data Summary Report 
• The design of this report is for a 132-column format. 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers, diagnosis codes and 
their associated descriptions are reflective of the date the event occurred.  

• After previewing the report, the user has the option to print or close the report. 

1. Enter a date range. 
2. Use the Patient Identifier field to select a patient. 

• Enter one of the following: 
– Patient Name (whole or partial, last name first) 
– Social Security Number 
– Last four digits of the Patient Social Security Number 
– First character of Last Name plus the last four digits of the SSN with no spaces 

• Click <Enter> or the Search button.   
• Choose from the list of patients displayed. 

3. Export, Preview, Print or Cancel the report. 

Figure 8.25. PCE Data Summary Report Required Information 
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Figure 8.26. PCE Data Summary Report from Print Preview 

 

Figure 8.27. PCE Data Summary Report from Export 
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8.1.8 Procedure Reasons Report 
• Locations, DSS Units, procedures, and procedure reasons must be defined before 

using this option. 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers, diagnosis codes and 
their associated descriptions are reflective of the date the event occurred. 

• After previewing the report, the user has the option to print or close the report. 
• This report is exportable into an Excel spreadsheet. The tab in Excel is titled 

“Reasons” followed by the Date Range the user selected. 

1. Select a date range. 
2. Select one, all or multiple Location(s). 
3. Select one, all or multiple Procedure Reasons. 
4. Select one, all or multiple DSS Unit(s). 
5. Export, Preview, Print or Cancel the report. 

Figure 8.28. Procedure Reasons Report Required Information 
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Figure 8.29. Procedure Reasons Report from Print Reviews 

 

Figure 8.30. Procedure Reasons Report from Export 
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8.1.9 Provider Summary Report 
• Locations, DSS Units, categories, procedures and procedure reasons must be defined 

before generating this report. 
• If Procedure Reason #1 is not listed, the report prints “Reason Not Defined”. 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred. 

• After previewing the report, the user will have the option to print or close the report. 

1. Enter a date range. 
2. Select one or all Location(s). 
3. Select one or all DSS Unit(s).  
4. Export, Preview, Print or Cancel the report. 

Figure 8.31. Provider Summary Report Required Information 
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Figure 8.32. Provider Summary Report from Print Preview 

 

Figure 8.33. Provider Summary Report from Export 
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8.1.10 Provider (1-7) Summary Report 
• The design of this report is for a 132-column format. 
• With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred. 

• This report provides the ability to view up to seven provider numbers for providers 
within a Location/DSS Unit. 

• Summarizes the workload of providers for a selected date showing how many times a 
specific procedure was performed on a patient with the selected provider as Provider 
1, Provider 2, through Provider 7. 

• After previewing the report, the user has the option to print or close the report. 

1. Enter a date range. 
2. Enter the name of a Provider. 
3. Export, Preview, Print or Cancel the report. 

Figure 8.34. Provider (1-7) Summary Report Required Information 
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Figure 8.35. Provider (1-7) Summary Report from Print Preview 

 

Figure 8.36. Provider (1-7) Summary Report from Export 
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8.2 Reports Available to ECMGR Key Holders Only 
In the example below, ECMGR reports are below the asterisk line.  

• Category Report 
• DSS Units with any Associated Stop Code Errors  
• DSS Units/Event Code (EC) Screens for Selected Procedure Code Report 
• DSS Unit Users Access Report 
• Event Code Screens with CPT Codes Report 
• Event Code Screens with Inactive Default Associated Clinic 
• Inactive Person Class Report (IPC) 
• National / Local Procedure Codes with Inactive CPT Codes 
• National / Local Procedure Report 
• Print Category and Procedure Summary (Report) 

Figure 8.37. Report Selection Screen for Holders of the ECMGR Key 
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8.2.1 Category Report 
• Use the Category - Add or Update Categories option to create categories before using 

this option. 
• This report is accessible to Management users only. This report will not appear for 

users without the management security key (ECMGR). 
• After previewing the report, the user has the option to print or close the report. 

1. Choose a status of Active, Inactive or Both. 
2. Export, Preview, Print or Cancel the report. 

Figure 8.38. Category Report Required Fields 
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Figure 8.39. Category Report (Active) from Print Preview 

 

Figure 8.40. Category Report (Active) from Export 

 

Figure 8.41. Category Report (Inactive) from Print Preview 

 

Figure 8.42. Category Report (Inactive) from Export 
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Figure 8.43. Category Report (Both Active and Inactive) from Print Preview 

 

Figure 8.44. Category Report (Both Active and Inactive) from Export 
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Reports - with any Associated Stop Code Errors 

8.2.2 DSS Units with Any Associated Stop Code Errors Report 
• The Event Capture software restricts DSS-only workload to use valid Stop Codes.  
• To assist sites in locating DSS Units that have invalid associated Stop Codes, the DSS 

Unit list with Secondary Associated Stop Codes option is provided. This may be 
attached as a secondary menu option and run as often as needed. The only prompt is 
for Device.  

• This report provides a list of DSS Units with any error with the Associated Stop 
Code. 

• The report provides the DSS Unit IEN and name, Associated Stop Code IEN and 
name and the reason for the error. 

• After previewing the report, the user has the option to print or close the report. 
• Select an active non-secondary Stop Code to replace the Stop Code in the DSS Unit 

set up. 

1. Select the report.  
2. Export, Preview, Print or Cancel the report. 

Figure 8.45. DSS Units with Any Associated Stop Code Errors Required Fields 
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Reports - with any Associated Stop Code Errors 

Figure 8.46. DSS Units with Any Associated Stop Code Errors 

 

Figure 8.47. DSS Units with Any Associated Stop Code Errors from Export 
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Reports – DSS Units/Event Code (EC) for Selected Procedure Code 

8.2.3 DSS Units/Event Code (EC) Screens for Selected Procedure 
Code Report 

• Only holders of the ECMGR security key can run this report. 
• After previewing the report, the user has the option to print or close the report. 
• This report is now exportable into an Excel spreadsheet. The tab in Excel is titled 

“Selected Procedure Code”. 

1. Select one, all or multiple Location(s). 
2. Select a Procedure. 
3. Export, Preview, Print or Cancel the report. 

Figure 8.48. DSS Units/Event Code (EC) Screens for Selected Procedure Code Report 
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Reports – DSS Units/Event Code (EC) for Selected Procedure Code 

Figure 8.49. DSS Units/Event Code (EC) Screens for Selected Procedure Code Report from 
Print Preview 

 

Figure 8.50. DSS Units/Event Code (EC) Screens for Selected Procedure Code Report from 
Export 
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8.2.4 DSS Unit User Access Report 
• This report is also accessible from the Grant Users Access menu option. 
• After previewing the report, the user has the option to print or close the report. 
• This report is now exportable into an Excel spreadsheet. The tab in Excel is titled 

“DSS Unit User Access Report”. 

1. Select a Location. 
2. Select one, all or multiple DSS Units. 
3. Export, Preview, Print or Cancel the report. 

Figure 8.51. DSS Unit User Access Report Required Fields 
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Reports – DSS Unit User Access 

Figure 8.52. DSS Unit User Access Report from Print Preview 

 

Figure 8.53. DSS Unit User Access Report from Export 
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Reports – Event Code Screens with CPT Codes 

8.2.5 Event Code Screens with CPT Codes Report 
• Users can print, preview or export Event Code Screens with active and/or inactive 

CPT codes for one or all DSS Unit(s).  
– For previewing or printing the report, when Both is selected for Active and 

Inactive CPT codes, all inactive CPT codes are flagged with an *I* indicator. 
– For exporting the report, all Inactive CPT codes are flagged with an **Inactive** 

indicator. 
• Users must have the Management Security ECMGR key to access this report. 
• After previewing the report, the user has the option to print or close the report. 

1. Select one or all Location(s). 
2. Select one or all DSS Unit(s). 
Note: If All is selected for the DSS Unit, the Category will also be All and will be disabled. 
3. Select a Category. 

Note: Categories only appear if the Event Code Screen uses categories to group procedures. 
4. Select Active, Inactive or Both (Active and Inactive) for CPT Codes. 
5. Export, Preview, Print or Cancel the report. 
Note: The tab of the report indicates whether the exported report shows only active, only 
inactive, or both active and inactive CPT codes. 
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Figure 8.54. Event Code Screens with CPT Codes Report Required Fields 

 

Figure 8.55. Event Code Screens with CPT Codes Report from Print Preview (Both Active 
and Inactive CPT Codes Selected) 
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Reports – Event Code Screens with CPT Codes 

Figure 8.56. Event Code Screens with CPT Codes Report from Export 

 
The tab of the report above indicates that the report is “Showing only Inactive CPT Codes”. 
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Reports – Event Code Screens with Inactive Default Associated Clinic 

8.2.6 Event Code Screens with Inactive Default Associated Clinic 
Report 

• Only holders of the ECMGR security key can run this report. 
• After previewing the report, the user has the option to print or close the report. 
• This report is now exportable into an Excel spreadsheet. The tab in Excel is titled 

“Inactive Default Clinic”. 

1. Select one, all or multiple Location(s). 
2. Select one, all or multiple DSS Unit(s). 
3. Export, Preview, Print or Cancel the report. 

Figure 8.57. Event Code Screens with Inactive Default Associated Clinic 
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Reports – Event Code Screens with Inactive Default Associated Clinic 

Figure 8.58. Event Code Screens with Inactive Default Associated Clinic from Print 
Preview 

 

Figure 8.59. Event Code Screens with Inactive Default Associated Clinic from Export 
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Reports – Inactive Person Class (IPC) 

8.2.7 Inactive Person Class Report (IPC) Report 
• This report shows providers who do not have a Person Class specified in the NEW 

PERSON file (#200) or who do not have an active Person Class in the NEW 
PERSON file (#200) for the date of the procedure. 

• After previewing the report, the user has the option to print or close the report. 

1. Enter a date range. 
2. Select Sort by Patient or Sort by Procedure. 
3. Export, Preview, Print or Cancel the report. 

Note: The column order does not change with Sort Method when exported into Excel. 

Figure 8.60. Inactive Person Class Report Required Information 
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Reports – Inactive Person Class (IPC) 

Figure 8.61. Inactive Person Class Report from Print Preview 

 

Figure 8.62. Inactive Person Class Report from Export 
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Reports – National/Local Procedure Codes with Inactive CPT Codes 

8.2.8 National/Local Procedure Codes with Inactive CPT Codes 
Report 

• This report provides a list of National and Local Procedure Codes with inactive CPT 
codes from EC NATIONAL PROCEDURE file (#725). 

• Users must have the Management Security ECMGR key to access this report. 
• After previewing the report, the user has the option to print or close the report. 

1. Select the report.  
2. Export, Preview, Print or Cancel the report. 

Figure 8.63. National/Local Procedure Codes with Inactive CPT Codes Requirements 

 

June 2015 Event Capture V. 2.0 GUI User Manual 99 
Patch EC*2.0*126 



Reports – National/Local Procedure Codes with Inactive CPT Codes 

Figure 8.64. National/Local Procedure Codes with Inactive CPT Codes Report Print 
Preview 

 

Figure 8.65. National/Local Procedure Codes with Inactive CPT Codes Report from 
Export 
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Reports – National/Local Procedure – Active Procedures 

8.2.9 National/Local Procedure Report – Active Procedures 
• Use the Procedure - Add or Update Local Procedures option to create local 

procedures before using this option. 
• This report is accessible to Management users only. For users without the 

Management Security key (ECMGR), this report will not appear.  
• After previewing the report, the user has the option to print or close the report. 

1. Click the Active button. 
2. Choose Preferred Report (National, Local or Both). 
3. Choose the Sort Method (Procedure or National Code). 
4. Export, Preview, Print or Cancel the report. 

Figure 8.66. National/Local Procedure Report (Active) Requirements 
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Reports – National/Local Procedure – Active Procedures 

Figure 8.67. National/Local Procedure Report (Active) from Print Preview 

 

Figure 8.68. National/Local Procedure Report (Active) from Export 
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Reports – National/Local Procedure – Inactive Procedures 

 

8.2.10 National/Local Procedure Report – Inactive Procedures 
• Use the Procedure - Add or Update Local Procedures option to create local 

procedures before using this option. 
• This report is accessible to Management users only. For users without the 

Management Security key (ECMGR), this report will not appear.  
• After previewing the report, the user has the option to print or close the report. 

1. Click the Inactive button. 
2. Export, Preview, Print or Cancel the report. 
Note: If the report is marked as Inactive, the preferred report and sort method will be 
disabled.  

Figure 8.69. National/Local Procedure Report (Inactive) Required Fields 
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Reports – National/Local Procedure – Inactive Procedures 

Figure 8.70. National/Local Procedure Report (Inactive) from Print Preview 

 

Figure 8.71. National/Local Procedure Report (Inactive) from Export 
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Reports – Print Category and Procedure Summary 

8.2.11 Print Category and Procedure Summary (Report) 
• Use the DSS Unit - Add or Update DSS Units option to create DSS Units categories 

before using this option. 
• Use the Category - Add or Update Categories option to create categories before using 

this option. 
• Use the Procedure - Add or Update Local Procedures option to create procedures 

before using this option. 
• This report is accessible to Management users only. This report will not appear for 

users without the management security key (ECMGR). 
• After previewing the report, the user has the option to print or close the report. 

1. Select one or all Location(s).  
2. Select one or all DSS Unit(s). 
3. Note: If “All” is selected for the DSS Unit, the Category will also be “All” and will be 

disabled. 
4. Select a Category. 
5. Note: Categories only appears if the Event Code Screen uses categories to group 

procedures. 
6. Select Active, Inactive or Both (Active and Inactive) EC Code Screens. 
7. Export, Preview, Print or Cancel the report. 

Figure 8.72. Print Category and Procedure Summary (Report) Required Fields 
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Reports – Print Category and Procedure Summary 

Figure 8.73. Print Category and Procedure Summary (Report) from Print Preview 

 

Figure 8.74. Print Category and Procedure Summary (Report) from Export 
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Management Menu 

9 Management Menu  
The DSS Management Menu is available for users with the ECMGR security key. The main 
menu in the Management Menu provides the following management functions: 

• Location – Update Location Information 
• DSS Unit – Add or Update DSS Units 
• Access by User – Grant Access to DSS Units by User 
• Category – Add or Update Categories 
• Procedure – Add or Update Local Procedures 
• Reason – Add or Update Procedure Reasons 
• Event Code Screen – Add or Update Event Code Screens 
• Inactivate EC Screen – Identify/Inactivate Multiple Event Code Screens 

Figure 9.1. Event Capture Management Main Menu 
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Management Menu – Location 

9.1 Location – Update Location Information 
Before the User Starts 

• Location selected must be in the INSTITUTION file (#4). 
• Locations must be created with this option before the user can establish DSS Units. 

No further options are functional until the user creates an Event Capture location. 

 

What the User Will See 

• Selecting the Location - Update Location Information option opens a screen that 
displays all the known location names, State, Facility Type, Station Number and 
Current Status in matrix form. Column size of the matrix is adjustable. 

• From the first screen double-click on a row or highlight a row and click the Update 
button. 

Figure 9.2. Management Menu (Locations) Screen 

 
After selecting a location, a second screen will appear to create the location as current or remove 
the selected location.  

Figure 9.3. Edit Location Screen 

 
The rows can be sorted by using the Sort menu or by clicking on the column header. 
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Management Menu – Location 

Figure 9.4. Sort Menu Options 

 
To create a current location, click the checkbox labeled “Create as current Event Capture 
location” and click the OK button. The location is “flagged” as active for use in the Event 
Capture software.  

Figure 9.5. Creating a Current Location 

 
To remove a current location, click the checkbox labeled “Remove as current Event Capture 
location” and click the OK button. The location is “flagged” as inactive for use in the Event 
Capture software. 

June 2015 Event Capture V. 2.0 GUI User Manual 109 
Patch EC*2.0*126 



Management Menu – Location 

Figure 9.6. Removing a Current Location 

 
Select the Export button to export the Locations listing to Excel and the tab in Excel is titled 
“ECS Location Table Export”. 

Figure 9.7. ECS Location Table Export from Excel 

 

June 2015 Event Capture V. 2.0 GUI User Manual 110 
Patch EC*2.0*126 



Management Menu – DSS Unit 

9.2 DSS Unit – Add or Update DSS Units 
Before the User Starts 

• Use the Location - Update Location Information option to create an Event Capture 
location before using this option.  

• A prompt displays a notification to enter an Associated Stop Code only if the "Send 
to PCE" flag is set to NO or NULL. 

• No further options are functional until DSS Units are created. 

What the User Will See 

• After selecting DSS Unit from the Management Menu, the first screen will display a 
list of DSS Units. Click the Update button to update an existing DSS Unit or click 
the Add button to add a new DSS Unit. 

Figure 9.8. DSS Units Screen on Management Menu 

 
Select Active, Inactive or All DSS Units. 

The DSS Units screen contains the following columns: 

• DSS Unit Name 
• Unit IEN 
• Active Status for DSS Unit (Yes or No)  
• The PCE column reflects if workload is set to pass to PCE. Values include:  

– ALL – Send all records 
– Outpatient – Send outpatient only 
– No – Send no records. 

• DSS Department 
• Service 
• Medical Specialty 
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Management Menu – DSS Unit 

• Cost Center 

Using the Find  button, the user can search by DSS Unit, DSS Dept. and Unit IEN. Type in a 
partial search string, click find and the screen will position to the first entry matching the search 
criteria. 

The Print button enables users to print the report.  

The Export button enables users to export the data to an Excel spreadsheet. 

Figure 9.9. Report Exported into Excel 

 
Click Update to update an existing DSS Unit or click Add to add new one. The “Edit a DSS 
Unit” or “Add a DSS Unit” screen will appear. 

Figure 9.10. Edit a DSS Unit Screen 

 
Below are the element name and description for each field that appear on the Add or Edit DSS 
Unit screen:  
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Management Menu – DSS Unit 

Table 9.1. Element Name and Description 

Element Name Description 
DSS Unit Name The name of the DSS Unit being created 
Service The service associated with this DSS Unit - from the Service/Section file (#49) 
Medical Specialty The medical specialty associated with this DSS Unit - from the Medical Specialty 

file (#723) 
Cost Center The cost center associated with this DSS Unit - from the Cost Center file (#420.1). 

Cost centers are defined in MP4-Part V, Appendix B of the Fiscal Service cost 
manuals. 

DSS Dept. and IEN The number to identify this DSS unit locally at the user’s site (1 to 14 characters) - 
The same DSS Unit number can be used for more than one DSS Unit  

DSS Unit Status Active - Lists Active Event Code Screens 
Inactive - Lists Inactive Event Code Screens 

Event Code Screens Reactivate 
Remain Inactive 

Default Date/Time NOW – The current date and time will populate during data entry 
NONE – The date and time will not be populated during data entry. The user will be 
required to enter it. 

Send to PCE Defines the method used to send the user’s data to PCE for the DSS Unit the user is 
creating. 
All Records - Send All Records 
Outpatient Only - Send Outpatient Only 
No Records - Send No Records 

Allow Category Use (Y/N) YES – Use categories to group procedures during data entry 
NO – Do not use categories to group procedures during data entry 

Associated Stop Code Select the Stop Code associated with this DSS Unit. Be sure to select an active Stop 
Code.  

Credit Stop Code Select the Credit Stop Code associated with this DSS Unit 
CHAR4 Code Selection the CHAR4 Code associated with this DSS Unit 

On add or edit screens, the status defaults to “Active.” The Allow Category Use field defaults to 
“No”, but the user can select “Yes”. The Send to PCE option can be setup for “No Records” and 
the Associated Stop Code field is enabled. A search for the Associated Stop Code can occur by 
description or code and both description and code display. The Send to PCE option can be set to 
“All Record” or “Outpatient Only” and the Associated Stop Code field will be disabled. All other 
default options can be changed. 

9.2.1 Instructions to Add a DSS Unit: 
1. Click on the Add button.  
2. Enter a DSS Unit Name.  
3. Enter a DSS Dept  
4. Select a Service from the list provided.  
5. Select a Medical Specialty from the list provided.  
6. Select a Cost Center from the list provided. 
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7. Select the DSS Unit Status 
8. Choose the Date/Time Default. 
9. Choose which records will be sent to PCE. 
10. Choose whether or not to Allow Category Use. 
11. Click OK when selections are complete. 

9.2.2 Instructions to Update a DSS Unit: 
1. Select a DSS Unit from the list of DSS Units and click on the Update button. 
2. A second screen will appear. On this screen the DSS Unit Name, DSS Dept., Service, 

Medical Specialty, Cost Center, DSS Unit Status, Event Code Screens status, Default 
Date and Time, Send to PCE, Code Allow Category Use, Associated Stop Code, Credit 
Stop, and CHAR4 Code field can be updated.  

Notes:  

• DSS Status may be Active or Inactive. 

• The Event Code Screen Options are different when Inactive is chosen for DSS Status. 

Figure 9.11. Original Active/Inactive Status 

 
When the DSS Status is changed, the Event Code Screens options also change. 

Figure 9.12. Change from Active to Inactive or Inactive to Active 

 
If the user selects Retain, the DSS Unit will remain active. If the user selects Inactivate, the DSS 
Unit that was active will be inactivated. Once a DSS Unit is inactive, the user can activate the 
DSS Unit again by selecting Reactivate. If the user selects Remain Inactive, the DSS Unit will 
remain inactive. 

3. Click OK when selections are complete. 

9.2.3 Granting Access to DSS Unit 
From the Add or Update DSS Units screens, the user has the option to give specific users access 
to the DSS Units selected. 

1. Click on the Access button at the bottom of the Add or Update DSS Units screens.  
2. The Grant Access to DSS Unit Screen has Include and Exclude fields. 
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3. There is a search field that enables the user to key in beginning characters of the last 
name above Include. Scroll through the list to search for a last name. The Exclude field 
contains the set up for all active users in VistA at the site. 

4. To give or take away access to a specific DSS unit, the management user must move the 
user’s names from the Included and Excluded boxes by highlighting the name and 
clickcin the Include or Exclude button. The name will move into the desired box. 

Note: The IEN and Person Class/Classification for each user appear below both Excluded 
and Included lists. 

Figure 9.13. Grant Access to DSS Unit Screen 

 
Note: Information has been deleted intentionally to preserve privacy 
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Management Menu – Access By User 

9.3 Access By User - Grant Access to DSS Units by User 
Before the User Starts 

• Use extreme caution when utilizing this option. Removing access to a specified DSS 
Unit for all users and inactivating the DSS Unit is not recommended without the 
permission of the associated service. 

• Contact each service for a list of its Event Capture users and the DSS Units for which 
they enter data. 

• The user must have access to DSS Units before procedure data can be entered. 
• Access can be provided to all DSS Units by assigning the ECALLU security key to a 

specified user (normally the DSS Manager or designee) using the Allocation of 
Security Keys option in the Key Management Menu under the Menu Management 
Menu.  

Note: This option cannot be used to remove access to DSS Units for users who hold the 
ECALLU security key. 

Instructions to Assign User Access to DSS Units 
1. Click on the Access by User - Grant Access to DSS Units by User button.  
2. When the screen opens, a list of users appears at the top of the box. Select a user. 

Figure 9.14. Grant Access to DSS Units by User 

 
3. Select the names of the DSS Unit(s) by highlighting the particular unit and clicking on 

the Include button.  
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Figure 9.15. Including DSS Units 

 
4. Click the Apply button to apply the changes and continue working or click the OK 

button to apply the changes the exit the screen. 
5. The user can print a list of users identified as having access to a given DSS Unit by 

selecting the Print button. 
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Management Menu – Category 

9.4 Category - Add or Update Categories 
Before the User Starts 

• The user can ignore this option if the site’s DSS Units are defined for use without 
categories. 

• Categories cannot be deleted but this option can be used to inactivate or reactivate 
them. 

What the User Will See 

• After selecting Category – Add or Update Categories from the Management Menu, 
the first window displays a list of Category Names, the Date created, and the 
Inactivation Date. 

Figure 9.16. Categories Main Screen on Management Menu 

 
• The second screen enables the user to add a Category or to update a selected 

Category. The second screen contains fields called Category Name and Status. 

Instructions to Add or Update Categories 

1. To add a new local category: 
• Click Add on the toolbar or in the Edit menu. The Status field defaults to “Active”. 

Figure 9.17. Edit Menu 

 
• Enter the new local category name. 
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Figure 9.18. Add Category 

 
• Click OK. 

2. To update an existing local category: 
• Click on the Category to activate status field. The Status field displays the status for 

the Category.  
• Change the category to its new status by clicking Active or Inactive. The results of 

this action will appear on the first screen. 

Figure 9.19. Update Category 

 
• Click OK. 

3. The Categories screen on the Management Menu will reflect the changes made. 
4. The Export button enables users to export the data to an Excel spreadsheet. 

Figure 9.20. ECS Category Table Export fromExcel 
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9.5 Procedure - Add or Update Local Procedures 
Before the User Starts 

• Before using this option, use the National/Local Procedure Report option on the 
Reports menu of the Event Capture Main Menu to print a list of procedures with their 
associated CPT codes. This report can be lengthy if it includes national procedures. 
This should be queued to print to a device during non-peak hours. 

• Enter an associated CPT code to pass local procedures to the PCE software. 
• A local procedure code number is required for any new local procedure.  
• The local number code must be five characters in length, starting with an uppercase 

alpha character, followed by four alpha or numeric characters. 
• With functionality put in place by the Code Set Versioning project, only active CPT 

codes are made available, and are based on the date a local procedure is added. 

What the User Will See 

• After selecting Procedure - Add or Update Local Procedures from the Management 
Menu, the first screen displays a list of Local Procedure Names, Procedure Number, 
CPT Code, and CPT Description and Active Status. 

Figure 9.21. Procedures Main Screen Management Menu 

 
• The second screen enables the user to add a Local Procedure or update a selected 

Local Procedure. The second screen contains the following fields: Procedure Name, 
Procedure Number, CPT Code and Description and Status.  
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Figure 9.22. Add Local Procedure 

 
• Procedures cannot be deleted but this option can be used to inactivate or reactivate 

them. 
• The CPT Code and Description field contains CPT Code look-up functionality. This 

makes a CPT Code searchable by the code, a part of the code, or a part of the 
description.  

• The option to print a list of the user’s current local procedures can be chosen. 
• When adding a Local Procedure Code, the system checks it against the National 

Procedure code format to prevent a Local Code that is already assigned as a National 
Code from being added. A message is displayed and the Local Code is prevented 
from being added. 

Instructions to Add or Update Local Procedures 

1. To add a new local procedure: 
• Click on the Add button in the Edit menu or on the toolbar. 

Figure 9.23. Edit Menu 

 
• Enter the new local Procedure Name. 
• Enter the local Procedure Number. 
• Enter the CPT Code if the data will transmit to the PCE software. 
• Click OK. The new local procedure has been added. 
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Figure 9.24. Adding a Local Procedure 

 

Figure 9.25. Update After Adding a Local Procedure 

 
2. To update an existing local procedure: 

• Highlight the original local Procedure Name and double-click or click the Update 
button.  

• Edit the Procedure Name, Procedure Number, CPT and Description and/or Status. 
• Click OK. The local procedure has been updated. 

Figure 9.26. Editing a Local Procedure 
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Figure 9.27. Update After Editing a Local Procedure 

 
• Select the Export button to export the Locations listing to Excel and the tab in Excel 

is titled “ECS Procedure Table Export”. 

Figure 9.28. Export of Procedures into Excel 
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Management Menu – Reason 

9.6 Reason - Add or Update Procedure Reasons 
Before the User Starts 

• Users with the ECMGR security key can activate or inactivate existing reasons. If a 
reason is listed as inactive, it will not appear on the dropdown list for reasons on any 
screen. 

• Users also can add a new reason using the Event Capture – New Reason screen.  

What the User Will See 

• After selecting Reason – Add or Update Procedure Reasons from the Management 
Menu, the first screen displays a list of Active Reasons and Inactive Reasons. 

Figure 9.29. Management Menu (Reasons) Screen 

 
To Activate Reasons: 

• Highlight the Inactive Reason(s) and click the Activate button. To move more than 
one reason, click and hold <Ctrl> and then highlight additional reasons. 

Figure 9.30. Reasons Screen with Inactive Reasons Highlighted 

 
• The Inactive Reason(s) selected will appear in the Active Reasons column. 
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Figure 9.31. Reasons Screen with Inactive Reasons Moved to the Active Column 

 
• Click the OK or Apply button to update the Reason(s). A confirmation prompt will 

appear. Click Yes to update and save the reason changes.  

Figure 9.32. Confirmation Prompt 

 
To Inactivate Reasons: 

• Highlight the Active Reason(s) and click the Inactivate button. To move more than 
one reason, click and hold <Ctrl> and then highlight additional reasons. 

Figure 9.33. Reasons Screen with Active Reasons Highlighted 

 
• The Inactive Reason(s) selected will appear in the Active Reasons column. 

Figure 9.34. Reasons Screen with Active Reasons Moved to the Inactive Column 

 
• Click the OK or Apply button to update the Reason(s). A confirmation prompt will 

appear. Click Yes to update and save the reason changes.  
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Figure 9.35. Confirmation Prompt 

 
To Add a new Reason: 

• Click the Add button. The Event Capture – New Reason screen will appear. 

Figure 9.36. Event Capture – New Reason Screen 

 
• Type the new reason. Click OK to add the reason to the Active Reasons column. 

Click Cancel to exit the screen. 

Figure 9.37. Reasons Screen with New Reason Added 
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9.7 Event Code Screen - Add, Update, or Copy Event 
Code Screens 

Before the User Starts 

• Use the Location - Update Location Information option to create an Event Capture 
location before using this option.  

• Use the DSS Unit - Add or Update DSS Units option to establish DSS Units before 
using this option. 

• Event Code screens must be defined before entering any Event Capture data. 
• A prompt for Category occurs only if the Event Code screen uses categories to group 

procedures. 
• The user must define an active Associated Clinic and CPT code to pass Event Code 

procedures to PCE.  
• With functionality put in place by the Code Set Versioning project, only active CPT 

codes can be selected and they will be based on the date the event code screen is 
being set up.  

• The Event Code screen enables the use of characters “/” and “-” in the search field. 
• The Associated Clinic on the Event Code screen is not auto-populated. 
• The Print and Export buttons have been added to the Event Code Screen. 
• Users with the ECMGR key will be able to copy EC screens to another DSS Unit  

What the User Will See 

• After selecting Event Code Screen - Add or Update Event Code Screens from the 
Management Menu, the first screen displays a dropdown box of DSS Units with their 
corresponding Categories and Procedures and Locations.  

• Select a DSS Unit to display the Event Code Screen data. Columns include Synonym, 
Procedure, Location, Category and Status.  

Figure 9.38. Event Code Screens Example 

 

June 2015 Event Capture V. 2.0 GUI User Manual 127 
Patch EC*2.0*126 



Management Menu – Event Code Screen 

• The Event Code Report can be printed. When printing the report, the user will be 
prompted to choose Active, Inactive or All for the Clinic Status. 

Figure 9.39. Select Clinic Status for the Report 

 
• The Event Code Table Report can also be exported to Excel. The user will be 

prompted to choose Active, Inactive or All for the Clinic Status. The Excel 
spreadsheet columns included in this report are Synonym, Procedure, Location, 
Default Associated Clinic, Category and Status. The spreadsheet tab is “Event Code 
Table Export”. 

Figure 9.40. Exported Event Code Table Report 

 
• Highlight the Procedure and select the Add or Update buttons. The Update Event 

Code Screen contains fields called DSS Unit, Category, Location, Procedure, Status, 
Procedure Synonym, Default Volume, Default Associated Clinic, and Ask Reasons. 
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Figure 9.41. Add Event Code Screen Example 

 
• Find and select an Associated Clinic. The look-up displays only active locations in 

the HOSPITAL LOCATION file (#44) whose type is “C” (clinic) and is a “count” 
clinic. In addition, if an Associated Clinic has non-conforming stop codes, the clinic 
will not be selectable.  

The following instructions and example assume that the user wants the specified DSS Unit to 
Send Data to PCE. 

Instructions to add an Event Code Screen 

1. After selecting a DSS Unit from the dropdown box, click the Add button in the toolbar or 
in the Edit menu.  

2. At the appropriate dropdown boxes select the DSS unit, Category (if applicable, 
otherwise disabled), Location (one/many/all), Procedure, Procedure Synonym, Status, 
Default Volume, Default Associated Clinic, and Ask Reasons.  

3. Click OK.  

Note: If the user does not select a Location when adding an Event Code Screen, the record 
will not be filed and the following two error messages will appear: 

Figure 9.42. Record Not Filed Error Message for Key Data Missing 

 
Click the OK button on each popup screen to return to the Add Event Code Screen and enter a 
Location. 
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Figure 9.43. Adding an Event Code Screen 

 
To Update an Event Code Screen 

1. Click on an Event Code Screen from the list of event code screens for a particular DSS 
Unit. 

2. Click the Update button in the toolbar or in the Edit menu.  
Note: An error message appears if a user selects an Event Code Screen that has an inactive 
Associated Clinic. The user has the option to select an appropriate active clinic or to leave 
the Associated Clinic blank. 
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Figure 9.44. Invalid Associated Clinic Error 

 
3. Update the Status, Procedure Synonym, Default Volume, Default Associated Clinic, and 

Ask Reasons.  
4. Click OK.  

Figure 9.45. Update an Event Code Screen 

 
Instructions to Copy EC Screens to Another DSS Unit 

1. Highlight a DSS Unit that has an ‘Active’ status. 
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Figure 9.46. Event Code Screen with Active DSS Unit Selected 

 
2. Click on the Edit menu and select Copy EC Screens to another DSS Unit. 

Figure 9.47. Copy EC Screens to Another DSS Unit on Edit Menu 

 
3. The Select a target screen appears. Select a target DSS Unit (usually newly created) from 

the dropdown list and then click OK. 

Figure 9.48. Select a Target Screen 

 
4. The Copy Event Capture Screen to <user-selected target DSS Unit> displays.  

• Location, Status, Procedure Synonym, Default Volume, Ask Reason and Default 
Associated Clinic can be modified on this screen. 

• The DSS Unit, Category, and Procedure cannot be edited. 
Note: The target DSS Unit is usually newly created by the user, but an existing DSS Unit 
may also be used. 
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Figure 9.49. Copy Event Code Screen 

 
• Location, Status, Procedure Synonym, Default Volume, Ask Reason and Default 

Associated Clinic can be modified on this screen.  

Note: If the DSS Unit is setup to not send records to PCE, the Default Associated Clinic is 
disabled. 
5. One, many or all screens can be copied. 

• To copy a screen, review the field selections and make edits (if necessary). Select the 
OK button to save the changes and to create the copy. The next screen will appear. 

• To skip an EC screen, select the Skip this EC Screen button. The next screen will 
appear. 

• When all needed screens are copied, select the Close button to return to the Event 
Code Screen. All of the previous changes will be saved. 

Note: If the user does not select a Location when copying an Event Code Screen, the record 
will not be filed and the following two error messages will appear: 

Figure 9.50. Record Not Filed Error Message for Key Data Missing 

 
Click the OK button on each popup screen to return to the Copy Event Code Screen and enter a 
Location. 
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9.8 Inactivate EC Screen - Identify Inactive Multiple Event 
Code Screens 

Before the User Starts 

• Users with the ECMGR security key can select an EC Product Code (CPT Code, 
National EC Procedure Code or Local EC Procedure Code) and then display all of the 
DSS Units using the selected Product Code in the Inactivate Selected Event Code 
(EC) Screens for Given Procedure Code.  

• Choose to inactivate Event Code Screens by utilizing the checkboxes in front of each 
entry. The user can display and print a list of Event Code Screens inactivated for a 
chosen EC Product Code. 

What the User Will See 

• After selecting the Inactivate EC Screen from the Management Menu, the first screen 
(Event Capture – Inactivate Selected Event Code (EC) Screens for Given Procedure 
Code) will appear. 

• Enter an Event Capture Product Code (CPT Code, National EC Procedure Code, or 
Local EC Procedure Code). The associated DSS Units with IENs, Locations and 
Categories appear for the EC Product Code selected. 

• Checkboxes are available to the left of each entry. The user can select multiple 
checkboxes. 

Figure 9.51. Inactive Selected Event Code (EC) Screens for Given Procedure Code 
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Instructions for Inactivating Event Code Screen(s) 

1. Enter an Event Capture Product Code (CPT Code, National EC Procedure Code, or Local 
EC Procedure Code). 

2. The list shows all currently active Event Capture Product Codes. Use the checkboxes on 
the left side of the screen to select entries to be inactivated. 

Figure 9.52. Entries Selected to be Inactivated 

 
3. Click the Apply or OK buttons to Inactivate.  
4. A confirmation pop-up will appear. Click Yes to Inactivate selection(s) or click No to 

return to the previous screen. 

Figure 9.53. Confirmation Pop-up for Inactive Event Code Screens 

 
5. If Yes is selected in response to the confirmation prompt, a listing of the Event Code 

Screens that were inactivated will be displayed. 
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Figure 9.54. Event Code Screens That Were Inactivated 

 
6. There will be an option to Print this list of inactivated screens or click OK to exit back to 

the first screen. 
7. To verify that the Event Code Screens are inactivated, reenter the Event Code Product 

Code that was previously used. The list of DSS Units, Locations and Categories does not 
include the inactivated Event Code Screens. 

Figure 9.55. Verifying that Screens Were Set to Inactive 
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Appendix A - Acronyms 
Acronym Description 

ADPAC Automatic Data Processing Application Coordinators 
ALC Alcohol 
CCOW Clinical Context Object Workgroup 
CHAP Chaplain 

CHAR4 
A 4-character code value of the associated clinic as specified from the 
DSS Clinics and Stop Code Worksheet File. 

CM Clinical Modification 
CPRS Computerized Patient Record System 
CPT Current Procedural Terminology 
CSV Code Set Versioning 
DIAG Diagnosis 
DOB Date of Birth 
DRG Drug 
DSS  Decision Support System  
Dx Diagnosis 
EC Event Capture 
ECALLU Event Capture All Units 
ECMGR Event Capture Manager 
ECNORPT Event Capture Reports 
ECPATIENT Event Capture Patient 
ECPROVIDER Event Capture Provider 
ECS Event Capture System 
ECSPSH Event Capture Spreadsheet 
EKG Electrocardiogram 
ERR Error 
EVAL Evaluation 
FAQ Frequently Asked Questions 
FEB February 
FY Fiscal Year 
GLF Gulf 
GRP Group 
GUI Graphical User Interface 
HBPC Home Based Primary Care 
HH Home Health 
ICD International Classification of Diseases 
ID Identification 
INDIV Individual 
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IP Internet Protocol 
IPC Inactive Person Class  
IRM Information Resource Management 
ISC Information System Center 
IT Information Technology 
JAN January 
JUN June 
MAS Medical Administration Service  
MAR March 
MGMT Management 
MGT Management 
MIN Minutes 
MISC Miscellaneous 
MRI Magnetic Resonance Imaging 
N/A Not Applicable 
NPCD National Patient Care Database 
O&E Observation and Examination 
PCE Patient Care Encounter 
PIMS Patient Information Management System 
REHAB Rehabilitation 
SEP September 
SHAD Shipboard Hazard and Defense 
SSN Social Security Number 
SW Southwest 
T&TC Section 508 Accessibility Testing and Training Center 
TXT Text 
VA Veterans Affairs 
VAMC Veterans Affairs Medical Centers 
VAMROC Veterans Affairs Medical and Regional Office Center 
VistA Veterans Health Information Systems and Technology Architecture 
VOL Volume 
W/O Without 
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Appendix B - Glossary 
Term Description 

Associated Stop Code The Stop Code that most closely represents the DSS Unit workload. 
Category Category provides Event Capture a common level to group associated procedures. 

Multiple procedures can be defined for each category. 
CCOW Clinical Context Object Workgroup 
CHAR4 Code A 4-character code value of the associated clinic as specified from the 

DSS Clinics and Stop Code Worksheet File. 
Cost Center Cost Center reveals which service is using this DSS Unit. Cost Centers are defined in 

detail in MP4-Part V, Appendix B of the Fiscal service cost manuals. 
Conforming Clinics Clinics that have stop codes in compliance with their restriction types. Stop codes are 

used in accordance to their assigned restriction types. Stop codes with restriction type 
'P' can only be used in the primary stop code position. Stop codes with restriction type 
'S' can only be used in the secondary stop code position. Stop codes with restriction 
type 'E' can be used in either the primary or secondary stop code position. 

Count Clinic A clinic for which workload entered is credited. 
CPRS Acronym for Computerized Patient Record System 
CPT code Current Procedural Terminology code 
CPT Modifier CPT modifiers provide the ability to refine CPT procedure codes to better reflect 

procedures performed. 
CSV Code Set Versioning 

The Health Information Portability and Accountability Act (HIPAA) mandated that 
applications using CPT codes, CPT modifiers, and diagnosis codes should allow users 
to select codes based upon a date that an event occurred.  

DSS Unit A DSS Unit (Decision Support System Unit) defines the lowest level segment used for 
tracking hospital resources. These units can be a small work unit within a service or a 
large division within a service. Management at each facility is responsible for tailoring 
the DSS Units to fit its resource/cost reporting. 

DSS Unit Number This code is used for additional identification of DSS Units. 
Event Capture Software designed to provide management tools necessary in tracking procedures not 

entered in other VistA packages. 
Event Code Screen Event code screens are unique combinations of location, DSS Unit, category, and 

procedure that define patient procedures. 
GUI Graphical User Interface 
ICD-9-CM International Classification of Diseases, Ninth Revision, Clinical Modification codes 

(based on the World Health Organization codes) 
ICD-10-CM International Classification of Diseases, Tenth Revision, Clinical Modification codes 

(based on the World Health Organization codes)  
IPC Inactive Person Class  
Location Initializing the user site as a location, the Event Capture software recognizes the user 

facility as a valid location to enter Event Capture data. 
MAS Acronym for Medical Administration Service, which is now Patient Information 

Management System (PIMS). 
Non-conforming Clinics Clinics with stop codes that do not comply with the assigned stop code restriction 

types of P=Primary, S=Secondary and E=Either. 
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Term Description 
Non-count Clinic A clinic for which there is no workload credited. 
Ordering Section The medical section ordering the patient’s procedure. 
Parent Service The controlling service for a DSS Unit. 
PCE Patient Care Encounter 
PIMS Patient Information Management System formerly Medical Administration Service 

(MAS). 
Procedure A specific function performed on, or service provided to, a patient. Multiple 

procedures can be associated with a single category. 
Procedure Reason A method of generically grouping patient procedures to further describe the event, 

often giving patient or provider information. 
Procedure Synonym See Synonym 
Provider The provider of care performing the procedure. This provider can be a doctor, nurse, 

technician, or any designated team of medical professionals. 
Reason See Procedure Reason 
Synonym A locally recognized name or description for a procedure 
T&TC Section 508 Accessibility Testing and Training Center 
Volume Volume is usually associated with the number of procedures performed. This field can 

also be used to track number of bed days, or to track time increments actually spent 
performing the procedure. (For example, if 15 minute increments is the unit, volume of 
1 = 15 minutes, volume of 2 = 30 minutes, etc.) 

VistA Veterans Health Information Systems and Technology Architecture 
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Appendix C - Synchronizing ECS with VistA 
Scheduling and PCE at the User’s Site 
Operations and Management (10N) has mandated that all clinical appointments, including walk-
ins, be scheduled in VistA Scheduling using count clinics. Surgery, Laboratory, and Radiology 
Services feed PCE and NPCD directly from their respective VistA packages and must be 
scheduled with non-count clinics to avoid double counting. ECS reporting is not used for these 
services. 

Non-clinical appointments such as scheduling transportation resources can continue to use non-
count clinics. 

DSS site teams and clinical staff using ECS reporting must adhere to the following instructions 
for clinical appointments to ensure coordination with VistA Scheduling and PCE. 

1. Create a count clinic in VistA Scheduling for scheduling purposes. 
2. Associate this clinic with the Event Code Screen and DSS Unit using the Event Code 

Screen – Add or Update Event Code Screens option in the Management Menu of the 
Event Capture software. Event Capture uses the Stop Code of the associated clinic to pass 
workload data to PCE. By passing data from Event Capture to PCE, the user will also be 
sending the data to Austin where it is filed in the National Patient Care Database 
(NPCD).  

3. In DSS, do not cost the clinic appointment product. Send it to a DSS statistics 
department. 

4. When recording workload in ECS, ensure the ECS Procedure Date/Time matches the 
date/time of the scheduled appointment. Complete the required encounter information to 
close out the encounter. 

Coordinate and review the above with clinical and administrative staff who use Event Capture, 
as well as with Scheduling and PIMS staff. 
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Appendix D - Summary of the PCE Filing Process 
Follow these steps to define an associated clinic for each event code screen that has DSS Units 
marked to send data to PCE. The options mentioned can found in the Event Capture 
Management Menu. 

1. Use the DSS Unit – Add or Update DSS Units option to update the SEND TO PCE 
information for each DSS unit.  

2. Use the Event Code Screen – Add or Update Event Code Screens option to create new 
event code screens or to modify existing event code screens. 

The DATE/TIME OF PROCEDURE field (#2) of the EVENT CAPTURE PATIENT file (#721) 
requires the entry of both date and time as part of every procedure date.  

Users must provide the following information for each procedure during data entry. 

• ICD-9 Diagnosis Code 
• If the selected patient has multiple eligibilities, users will be prompted to select the 

eligibility that applies to the specified procedure. The PRIMARY eligibility is 
displayed as the default. 

• A response to the classification questions for patient procedures is required only if 
they apply to the patient. 

• If a procedure is associated with a CPT code, then users will be prompted to enter 
CPT modifiers. 

• Associated Clinic 

After the PCE-related prompts are answered, all appropriate patient records are formatted to file 
the data with PCE. This formatted data string is stored in the PCE DATA FEED field (#30) of 
the EVENT CAPTURE PATIENT file (#721). The flag to file this record is then set in the 
SEND TO PCE field (#31) of the EVENT CAPTURE PATIENT file (#721). 
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Appendix E - Other ECS Package Management 
Information 
Set up an ECS mail group in VistA to receive relevant ECS notifications. Contact IT to set up a 
VistA ECS Mail Group so more than one person receives ECS administrative messages. 

Examples of ECS package administrative Email messages: 

1. When a new ECS patch is released. 
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2. When an EC NATIONAL PROCEDURES file (#725) patch is loaded, a review of the 

EVENT CODE SCREENS file (#720.3) is performed. Event Code Screens, which have 
either inactive CPT or Event Capture Codes, or an Event Capture Code with an inactive 
“default” CPT code attached, are reported. 
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Notes: 

• After a patch updating file #725: 
• Check for inactivated national EC Procedure Codes. 
• Check for Event Code Screens with out-of-date EC Procedure Codes. 

3. When an ECS User is terminated. 
(May inactivate national EC Procedure Codes and report any Event Code Screens with out-
of-date Procedure Codes.) 

June 2015 Event Capture V. 2.0 GUI User Manual 145 
Patch EC*2.0*126 



Appendix E - Other ECS Package Management Information 
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